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FREE DOWNLOADS!

If you’d like to follow along with the step-by-step Photoshop techniques presented in

chapters 2 through 14, go to www.AmherstMedia.com to download low-resolution copies

of the original files.



Jerry D is not only a gifted photographer and Photoshop wizard, he
is also a licensed cosmetologist and hairdresser, as well as a black belt

in the Chinese martial art of kung fu. Jerry did not see the pieces of his
life coming together, but one by one he perfected each craft until one day
he saw what he could do for people.

The Importance of Our Image

When Jerry realized how he could change a subject’s appearance by
doing their hair and makeup, he was hooked. People were amazed—
especially those who had never worked on themselves like that. When
Jerry began doing makeovers with people, he realized that their security
was “all in the mirror.” He says, “From the time you’re old enough to
recognize yourself in the mirror, this is when you start liking yourself and
accepting yourself. Self-acceptance begins with the reflection we see,” he
says. “This image is so strong that we compare everything we do for the
rest of our lives to the way we feel about ourselves when we walk away
from the mirror.”

Changing Points of View

Because the mirror only shows us one point of view, you don’t get the full
perspective; you can’t see yourself from all the different sides, the way
other people do. “So anytime we break out of this way of seeing our-
selves,” says Jerry, “it’s very scary and a lot of things happen.” For most
of us, it took a long time to accept ourselves the way we are and to be
happy—and insecurities often arise because we’re not sure if we’re being
accepted by others.

This works on a lot of different levels, according to Jerry. In relation-
ships, for instance, people can sometimes become insecure and anxious
when one person changes the way they look. They feel that they don’t
know the other person, or that the other person is changing somehow.
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never worked on them-
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Our perceptions of the people around us underlie relationship funda-
mentals like honesty and trust. According to Jerry, these perceptions de-
pend largely on how others see you—and the image that they expect to
see when they look at you.

“When we’re changing someone’s image—the extreme makeover—
we want to do what’s going to look best for them,” Jerry says. When you
do someone’s makeover and they look really good, he says, you can see
the apprehension on their faces. When people see themselves and are
amazed at their new look, they don’t really know if they’ll be accepted by
others.

Jerry D got into photography so he could show people how good they
look from his redefined point of view and from different perspectives.
He remembers that an interesting thing happened when he started show-
ing people prints of themselves after their makeovers. They really didn’t
perceive the images to be like themselves at all. They suddenly saw them-
selves much more objectively. They would say things like, “I like the way
this person looks in this image,” as if they were talking about someone
else. It was a much easier transition to like themselves in images. Jerry
says, “The more I photographed these changes in people, the more I re-

JERRY’S EDUCATION AND TRAINING

Jerry studied cosmetology at Citrus College in Glendora, CA, then gradually got

into the styling business, primarily cutting hair. While he was in school, he met

Tony Beckerman, a world-renowned hairdresser who ran all the Vidal Sassoon

schools. Jerry says of Beckerman, “He was on the cutting edge of all the new de-

signs in hairstyling. It turned out he was also interested in kung fu and so I ex-

changed lessons in kung fu for

lessons in cutting hair from one of

the legends of hairstyling. So, while

I was still in school, I was able to

come back and share the latest and

greatest techniques for cutting hair

with the other students.” (Note: Jerry

credits kung fu for giving him the

discipline and confidence to achieve

his goals. “Kung fu allows you to

overcome anything you want,” he

says. “It also gives you the vision

and ability to look beyond what you

see.” Jerry believes that the ancient

discipline is not something you do,

but something you become. It’s a

way of thinking; a respect for one-

self. Understanding oneself and

your own insecurities makes you

able to identify with everyone.)

Jerry is seen in traditional dress of the
kung-fu master, a distinction earned after
achieving the eighth-degree black belt.
This is a self-portrait, and yes, that’s a
sword, which is part of the traditional
garb.

Jerry D got into

photography so he could

show people how good

they look . . .



alized how much I liked the photography end of things.” This propelled
him into starting to photograph his “befores” and “afters.”

When Jerry graduated, he was able to cut hair every day; in the
evenings, he ran his kung-fu school. This went on for about ten years. He
eventually became what is known as a platform artist, giving demonstra-
tions and workshops to other designers at trade shows and other events.
He worked for a number of different companies, but didn’t really get
into the makeup end of styling until he had established his photography
business.

Once he was accomplished enough to consider himself a photographer,
however, he realized he was at the mercy of other hairstylists and makeup
artists—people who not only had different philosophies than his own on
beauty, but didn’t necessarily share Jerry’s vision of what the final look
should be. “Whatever they did was what you had to work with,” he says.

In order to come full circle and have full control of everything about
the person’s look, he decided to learn how to apply makeup profession-
ally. When combined with his hairstyling skills, this allowed him to do
complete makeovers for his customers—and create images that would
absolutely mesmerize them.

When he learned how to apply makeup like an artist, everything
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A SPECIAL RELATIONSHIP

Letters from Jerry D’s clients reveal a very special relationship between the pho-

tographer and his subjects, and the vulnerability of the client and the power of

the photographer. The dynamic is not to be abused; it is a crucial point in the

photographer’s reputation and ability to generate word-of-mouth referrals. It is

amazing to see the reverence with which so many of Jerry’s clients hold him.

He is a god and an imagemaker in the true Hollywood sense—and in many

cases, he is solely responsible for bringing his customers back from a long,

dark path of emotional discontent. It might be hard to believe that there is such

an intense connection between the two parties, but it’s true—as you will see

when you read some of the letters included here. The relationship between the

photographer and subject can be as thick as blood.

The photographic experience, the “session,” is both horrifying and cathartic

to a client. They are terrified they won’t measure up, and yet they are oddly

soothed by the comforting, nurturing attitude of the photographer. The subject

gives up control and lets down all defenses, giving the photographer the power

to reshape them in any way he sees fit. Like a “sure thing” at the racetrack, self-

confidence and self-assuredness surges and, with few exceptions, the session

is a smashing success and the client walks away filled with good feelings about

themselves. It’s a truly amazing relationship!

A simple quote about Jerry from one of his clients says it all: “He was able

to see my beauty, inside and out.” That’s the kind of complete faith he inspires.

It’s actually quite amazing.

He realized he was at the

mercy of other hairstylists

and makeup artists . . .



changed. He would see the face as a blank canvas and begin to sculpt the
face using highlight and shadow (as described in the forthcoming chapter
on makeup). He realized that one technique did not work for everyone.
Each face was different and you had to literally start at the beginning for
each face—define the contouring of the cheekbones, define the eyes, lips,
nose, and mouth—so that the finished look would be unique and “right”
for that person. He was also amazed at the variety of different faces he
would encounter—long faces, wide ones, square ones, and luckily, an oc-
casional oval face—the ideal.

Four Professions in One

Over the years, Jerry has come to realize that he is talented in four dis-
tinctly different areas: makeup, hairstyling, photography, and Photoshop,
which he says is an extension of his artistry. To see Jerry manipulate an
image is pure magic, because he never spends more than ten minutes per-
fecting an image and knows innately what he wants to do to perfect the
look. He takes it as far as he can photographically, but from there, because
of build-ups of local contrast in the face as well as minute skin imperfec-
tions, Photoshop becomes the only way to finish the idealization of his
subjects.

This Book

As the title states, this book is about makeovers and the power of remak-
ing a person’s image. As you will see from the notes and letters from the
people Jerry has worked with, the process has a profound effect on both
their self-image and the image they project to the world. Jerry is de-
lighted to be able to empower people in this way. It is our hope that we
can bring you enough technical information that you can begin to recre-
ate this profound type of makeover in your own studio environment.

We have tried to include as many unique makeovers as space allowed.
In most instances, the “how to” portion of the book deals with Photo-
shop shortcuts and techniques to make the less labor intensive and more
easily adapted into a “normal” kind of workflow.
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the idealization of
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In this day and age, men and women are bombarded with im-

ages of perfect faces and bodies accompanied by perfect cloth-

ing and makeup. We are made to feel that if we want to be

attractive, we have to have the perfect body, the perfect

makeup, the right fragrance, and so on. From the time we wake

up in the morning to the time we go to sleep, we try to live up

to these standards of accepted beauty that have been set for

both men and women. “I would love to say that my clients were

all top fashion models with flawless beauty,” says Jerry, “but

that’s not my reality. My clients are ordinary people with their

own insecurities.” Most of us don’t want to have our picture

taken because we are the first to pick out our own flaws—and

who would want a photograph of themselves that they see as

unflattering? It becomes a bold attack on all the imperfections

we see in ourselves. It is a reminder of how far we really are

from the flawless beauties in the magazines.

All people are beautiful. We say that beauty is in the eye of

the beholder, yet that definition is different for everyone.

Learning to love begins with you. Learning to see your own

beauty is the beginning of healing and self worth. “A large per-

centage of women I’ve talked to are subconsciously comparing

themselves to other women—namely supermodels— con-

stantly,” says Jerry. “The truth is that men, husbands and

boyfriends alike, pick up the latest magazines with super beau-

tiful women, and think to themselves, ‘If only I could only meet

a woman with that beauty, I’d be willing to trade in’—as if they

were buying a better vehicle than the one they have. The man

forgets, or doesn’t realize, that these models have the top

makeup artists, great photographers, and

amazing Photoshop experts to help create

the illusion of the image they project.” Jerry

adds, “The benefit of the portraits I do is

that average women are those supermod-

els. Looking at a beautiful image of their

wife or significant other, men suddenly re-

alize that they do have their very own cen-

terfold—one that is now more real and

more valuable than the fantasy version in

the magazines, because they actually know

the woman behind the image.”

An artist has the capability of changing

reality and offering a certain interpretation

of any particular image. He is guiding the

viewer’s perception through his eyes and

his work. The viewer’s mind wants to put

order to what it sees. For example, back

when the large 60-inch televisions first

came out, standing five or six feet from the

screen you would think to yourself what a

terrible picture it was because of all the

pixilation. Yet, if you were to walk twenty

feet away you would see a high-quality pic-

ture—razor sharp. This is because your

mind’s eye would fill in the gaps and put

order to the pixilation.

Looking at anyone’s artwork, we see all

the imperfections in the brush strokes, but

art was meant to be appreciated for the

feeling it creates as our minds fill in the

gaps.

EVERY WOMAN IS A “CENTERFOLD”

One of Jerry’s favorite subjects, Barbara, is
seen in one of the outtakes after her
makeover.



Evaluating the Face

The first thing you should do when you meet a client is look at her facial
structure (image 1-2). The face is a canvas, and it will dictate how you will
do the makeup. The perfect face structure is oval. Most people, however,
don’t have an oval-shaped face. Most people’s faces are more square, cir-
cular, or diamond-shaped. With every one of those non-oval shapes, your
goal will be to put “oval” back into the face. This will be accomplished
using lights and darks, highlights and shadows.

Sculpting with Highlight and Shadow

In this chapter, we are going to keep it very simple, using basically the
minimum amount of makeup to achieve the desired look. To sculpt the
face (in this case, our subject Zandalee’s face), we’re going to use con-
touring powder that is two shades darker than the subject’s skin tone in
the areas where we want to create shadows and highlighter powder that
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1. Basic Techniques: Makeup and Photoshop

1-1. Here are the makeup essentials. As you can see, not all that much is required
to do a complete makeup makeover.

1-2. The first step is evaluating the
subject’s face.



is a couple of shades lighter that the skin tone in the areas where where
we want to create highlights. It is important to choose a color-neutral
contouring product for adding shadows and highlights. The only makeup
products that should bring color to the face are the lipstick, lip liner,
blush, and eyeshadow. The color-neutral parts of the makeup should look
like natural highlights and shadows.

Let’s look at an example of what we want to achieve at this point. If
we paint a red circle (image 1-3), it looks completely flat—it’s just a big
red circle with no depth or contour to it. By adding a dark shadow to one
side (image 1-4) and a highlight to the other side (image 1-5), however,
we can make the red dot look like a sphere—we can give it the appearance
of a three-dimensional shape. We want to do the same thing to the face
by applying makeup.

Shadow Contouring

As we’re working with shadow contouring, we’ll start directly along and
under the cheekbone. In image 1-6, note the position of the finger—that

1-3. Without highlight or shadow, this
is just a red circle.

1-4. Adding shadows gives the circle
some dimension.

1-5. Adding highlights completes the il-
lusion, making the flat circle look like a
three-dimensional sphere.

1-6. The finger indicates where con-
touring is needed along and under the
cheekbone.



is where you want to place the contouring shadow. You want to take
some of the darker contour color and brush it upward underneath the
bone structure, putting the heaviest concentration of color there (image
1-7). You must also blend this tone down into the jawline (image 1-8); if
you don’t, the white jaw beneath the brown makeup will pop out unnat-
urally. Visually, what happens is that light tones advance while dark tones
recede.

Brush the same dark contour along either side of the nose. This defines
and narrows the nose. In image 1-9 you can see the “shadow” on both
sides of the bridge of the nose. We’re still working just with shadows.
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1-7 (top left). Blending of the contour-
ing powder down onto the jaw line.

1-8 (top right). The contouring is
blended along the cheekbone and
down onto the jaw. Here, you also see
the two neutral colors of contour that
we are using on our model.

1-9 (left). Applying shadow contouring
to the sides of the nose.



Our next step is to apply the dark contour under the jaw line. Remem-
ber that photography will enhance the contrast, so it is important to
blend these tones smoothly with the natural skin color (images 1-10 and
1-11).

By applying makeup in just these three areas, we’ve created contour
and depth on the face. In images 1-12 and 1-13 you can see both sides of
the face; with the contouring added, the nose looks narrower and the
face has areas of light and dark that create roundness and depth. All of this
was done without changing any of the lighting.

BASIC TECHNIQUES: MAKEUP AND PHOTOSHOP 15

1-10 and 1-11. Our next step is to apply
the dark contour under the jaw line.

1-12 (left) and 1-13 (right). The sub-
ject’s face before and after contouring.



Adding Blush

Our next step will be placing blush directly on top of the cheekbone.
Blend it with an upward stroke and then blend it into the contoured area
a little bit as well (image 1-14). It should blend completely, so that there
are no clear lines of demarcation from area to area.

Adding Highlights

We’re now going to work with the highlights. This will further bring out
those cheekbones. Apply a highlight to the cheekbone (image 1-17) as
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1-14. Blush is applied on top of the
cheekbones.

1-15. Here you can see the difference
between the blush, which adds visible
color, and the neutral-toned contour,
which doesn’t.

1-16. You can see that we’ve already
defined the facial structure, giving the
model strong cheekbones and good
facial contouring.

1-17. Applying highlighter to the tops
of the cheekbones.

1-18. Applying highlighter to the
bridge of the nose.

1-19. The model with the blended high-
lights in place.



well as to the bridge of the nose (image 1-18). (Note: Highlighters should
not include metallic flakes; these will look like dust specks in the final
image.) Our eye will go right to the highlights, so if there’s anything you
want to diminish or shorten, use shadow; if there’s anything you want to
accentuate or lengthen, use highlight. Image 1-19 shows our model with
the highlights blended and in place. Now, it’s on to the eyes.

The Eyes

We want the eyes to show depth and roundness. If we just plant color on
them, people will say, “Oh, nice eyeshadow.” We don’t want them to see
the color, really. What we want to do is create depth around the eye using
the same principles of shadow and highlight we used to sculpt the rest of
the face—dark tones recede, while light tones advance.

Dark Shadow in the Crease. Our first brush stroke will be made with
a dark tone of eyeshadow at the crease of the eye, because that’s where
we want it to recede (image 1-20). This will make the eye look deeper.

1-20. A dark stroke is applied in the
crease of the eyelid, making the eyes
look deeper.



Color and Highlights. Next, we’ll blend a lighter—in this case, a
light-green eyeshadow—beneath the dark area, blending the two colors
together (image 1-21). We’ll leave the center of the eyelid sparsely cov-
ered because our next step is to add a highlight there, creating roundness.
With the highlighter, we’ll add a light tone along the base of the eyelid
and in the center of the eyelid to create highlights (image 1-22). We’ll
complete the look using a highlight beneath the brow (as shown in image
1-23).

The look so far, applied to both eyes, is seen in image 1-24. As you can
see, the eyes appear deeper and more dramatic.
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1-21. Blending on a light-green eyeshadow. 1-22. Adding highlights along the base of the eyelid and in
the center of the eyelid.

1-23. Applying a highlight beneath the brow. 1-24. Here, you can see the eye finished. It looks deeper and
more dramatic.



Mascara and Eyeliner. You want to brush the mascara onto the eye-
lashes with an upward stroke, making them longer (image 1-25). If your
subject doesn’t have long eyelashes, sometimes you’ll also want to use a
darker eyeliner to make the lashes look more contrasty and noticeable.

Eyebrow Arching. This is one of the most important factors in
makeup application. The blusher and the contouring we did on the
cheekbones form the bottom part of a frame for the eye; the eyebrow is
the other part of the frame that contains the eye. The two work together
in framing the eye.

As seen in image 1-26, to determine the ideal high point for the eye-
brow, start at the center of the right eye and position a pencil (or, in this
case a makeup brush) one pencil-width to the right of the center of her
pupil. This is where the arch of the eyebrow should be. Next, move the
pencil one pencil-width to the left of the pupil (image 1-27). This is the
corner of the eye, and if you draw a line straight up from that point, this
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1-25. Applying mascara with an upward
stroke.

1-26. Positioning a pencil to determine
the ideal high point for the eyebrow.

1-27. Positioning a pencil to determine
where the eyebrow should begin.

1-28. Positioning a pencil to determine
how far the eyebrow should extend.



is where the eyebrow should begin. Next, position your pencil diagonally
from the corner of the nose to the corner of the eye (image 1-28). This
is how far the eyebrow should extend.

What’s really important about this is the illusion that the eyebrows cre-
ate. When the eyebrows are too short or too small, the subject’s face will
look rounder, heavier, and longer. If you allow the eyebrows to extend
too far outward toward the ear line, the face will look broader—but if
you measure from the corner of the nose to the corner of the eye, the eye
and the eyebrow are placed in a direct relationship with one another and
the face looks more proportionate. This makes the eyes look more open
and natural, slims the face, and provides a natural frame for the eye, based
on its shape and the dimensions of the face. (Note: When the eyebrows
are too long [going almost to the center of the nose] or too thin, the
person will be perceived as looking angry. Rectifying this situation is use-
ful for both men and women—particularly for individuals who frequently
deal with the public.)

In image 1-29, the extra hairs are being removed. You really don’t need
to remove a lot of eyebrow hairs. “I’m using my thumb at the high
point,” says Jerry D. “I’m lifting there, so I know where I’m going. I’m
epilating the hairs just at that peak. When I pluck those hairs, it starts
giving me a line toward that peak, giving me the illusion that the brow
is arching up, from the beginning of the brow. You want to extend that
line straight down, to the extension, completing the arch.” You may, at
times, have to use a little eyebrow pencil to extend the line of the brow
to its natural conclusion.
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1-29. Removing extra hairs to create
the desired line in the eyebrows.

This makes the eyes

look more open

and natural . . .



In image 1-30, you can see a dramatic difference between the left eye
and the right eye. The right eye looks almost flat—not as open as the
left. Yet, the makeup is the same on both eyes; the only difference is the
eyebrows. The finished eye looks more open.

Applying Color to the Lips

If you just apply color to lips, they become very flat. Regardless of the
shape of a person’s lips, you can make them fuller by applying a line just
outside of the natural line of the subject’s lips. Bottom or top, you don’t
have to stay within the perimeter of the person’s natural lip line.

To accomplish this shaping, Jerry uses a lip liner. This is a darker shade
of lip coloring that essentially does what the neutral dark contouring does
for the cheekbones of the face; it holds everything in and would be con-
sidered the shadow. Line all the way around the lips, shaping them. If
the lips are flat on top, you can put a little more point in, giving them
more definition. Again, you can also make them fuller by going slightly
outside the natural line of the lips.
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1-30. The only difference between the
two eyes is that the right eyebrow has
been shaped, while the left has not. As
a result of this shaping, the right eye
looks more open and attractive.

1-31. Applying lip liner helps to make
the lips look fuller.

1-32. Here you can see the difference
between the part of the lip that is done
and the part that isn’t. We’ve started to
define the lip line, making it sharper.



Now, apply lipstick that is a little bit lighter than the lip liner (image 1-

33). As you can see in image 1-34, the overall effect on the lips isn’t quite
working yet; we need to add highlights to the lips to give them roundness
and dimension.

To complete the look, a lighter-colored lip gloss is used to apply a
highlight to both lips toward the center (image 1-35)—and you can def-
initely see the difference (image 1-36).
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1-33. Applying lipstick that is a little bit
lighter than the lip liner.

1-34. With only the lip liner and lipstick
in place, the lips still look a little flat.

1-35. Applying a light-colored gloss to
add highlights on the lips.

1-36. The lips with the lip liner, lip-
stick, and highlights complete.



Before and After Makeup

You can now see the difference between the before and after looks. Image
1-37 shows our subject, Zandalee, with no makeup. Image 1-38 shows
her after the completion of the makeup process described in this chapter.
Neither image has received any Photoshop treatment at all.

After her makeup was complete, Zandalee’s hair was blown out nice
and straight and she was ready to do some variations on the makeover.

The basic techniques outlined above were used throughout this book
each time a new subject arrived at Jerry’s studio to be photographed.
Often, there was no hairstyling done for the client. Makeup is an impor-
tant part of the process; it not only makes the subject feel great, it also
drastically minimizes the amount of retouching that is required in the
postproduction process.
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1-37. Zandalee before makeup. 1-38. Zandalee with makeup.



The ABCs of Photoshop

The photographic process, even digital capture, is not always kind to the
human face. Even after Zandalee’s makeover, you can see in the original
capture (1-39) that the camera does not lie (yet). There is local contrast
built up on her face, and even though there is a solid foundation of
makeup, imperfections in the skin and hair are plentiful. Also, her bangs
blocked some of the light from her eyes, creating a shadow over them
(this is corrected in image 1-40). Also, her skin did not have the soft, ra-
diant glow that is a trademark of Jerry D’s makeovers (as in image 1-41).

Let’s look at some more Photoshop makeovers with Zandalee—this
time in more detail. The Photoshop techniques employed to bring to-
gether the finished images are quite similar throughout these examples
because the lighting and makeup were almost identical throughout. Un-
derstanding this can help to streamline your workflow.
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1-39. Even after her makeover, there are a few issues that will
need to be addressed in postproduction.

1-40. Here, skin and hair imperfections have been addressed
and the shadow cast by her bangs onto her eyes has been re-
moved.



You can see from the first “straight” image (1-43; next page) that dig-
ital capture is very sharp and unforgiving. Some surgery was called for in
Photoshop—just to take the edge off of Zandalee’s features. In Jerry’s
words, “The first thing I did was go in with the Clone Stamp tool and
even up the edges of her hair. Then, I blended the skin, again using the
Clone Stamp tool at 30 percent opacity and 67 percent flow and a fairly
large brush size. I cloned out everything I didn’t like in the photo. I
don’t like to do it too heavily. I like a light touch so I get a soft effect. The
trick is to blend things together subtly.”

At this point, says Jerry, “I also do my ‘cosmetic surgery.’ I remove or
alter anything that they probably won’t want to see—like a little crooked-
ness in the nose, which is fairly common. For instance, here, I’ve evened
out the bridge of the nose a little bit because it’s uneven and a little bit
wide in the original capture.”
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1-41. In this image, the soft, glowing skin that characterizes
Jerry D’s images has been added.

1-42. Converting the image to black & white creates another
look.



When asked what he looks for in cloning the skin surface, Jerry says,
“To find a target area, I look at the skin tones that I want to keep, and
use those areas as targets.” (Note: When using the Clone Stamp tool, you
must first select an area to clone. Then, when you click on an area to
paste that information, the tool draws information from the target area.)
“What I’m looking for is tonality, because you don’t want to put a high-
light into a shadow area,” he says. “As long as the skin tone is the same
relative tonality as the area you want to blend, you can use the same target
area over and over.”

Next, says Jerry, “I come in with my Dodge tool and lighten the whites
of the eyes with it. I remove just a few of the blood vessels—but not all
of them. Otherwise you get an unnatural look. I use an exposure setting
of 10 percent (with highlights selected in the range setting), and a soft-
edged brush small enough to fit inside the whites of the eyes.

“To subtly bring up the color of the eyes, I use the same brush size
with the Dodge tool and just hit the colored area once or twice. I might
also do the same with the catchlights in the eye to make them whiter and
give them a little more snap. I might do that several times. The eyes are
so important in a portrait. In every portrait I do, I want people to look
first at the eyes.

“At this point, I save what I have done so far, and I usually save it with
an ‘a’ designation—like ‘cb1244a.jpg’. That’s my first level of retouching.
You will notice that I have not worked on a duplicate background layer
so far, but on the original. The reason I feel safe doing that is that (1) I
often shoot RAW, so there is always an untouched original, and (2) what
I’ve done so far is very simple and I’m not worried about damaging the
file. I always use the ‘Save As’ command (File > Save As), thus preserving
the original—and if I do make a mistake and go too far, I simply don’t
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1-43 (above). The original image.

1-44 (right). The retouched image.



save it. I revert to the original JPEG and I’ve only lost five minutes or so.
“After doing this, I then close the file and reopen it. The next step is

to create a background copy layer. Then I apply the Gaussian Blur filter
(Filter > Blur > Gaussian Blur), setting the radius to 20 pixels. I want to
blur the background and make the skin very soft. I love Photoshop’s abil-
ity to give you a wide range of control over these effects. While there are
many fine tools for softening the image, Photoshop’s Gaussian Blur gives
you the ultimate in control, which is important if you want to vary the
amount of softness on the person’s face.

“Working on the blurred duplicate background layer, I choose the
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Eraser tool set at 30 percent opacity and with a fairly large brush size.
Then, I hold down the mouse down with one click, and erase everything
that I want to sharpen with little circles, just as if you were waxing a car.
I start around the perimeter of the person and I effectively sharpen the
edges of the image with one maneuver. I don’t want my background to
be strong, so I pretty much leave that alone. The entire purpose of this
is to have really soft skin, but it still has to be believable, so I go in stages.
The lowered opacity helps to blend the sharper areas (the erased areas)
with the softened areas, so the effect is not noticeable.” (Note: When
erasing a duplicate background layer, as Jerry does in this step, you are
erasing from a layer that is above your original; erasing simply allows the
original image data to become visible through the upper layer.)

Jerry continues, “Then, I go back over additional areas with the same
settings on the Eraser tool. I go over the hair to bring out the strands. I
go over the face a bit, particularly the eyes, eyelashes, eyebrows, bridge
of the nose, lips, tip of the nose, and chin. These are all areas that need
to appear sharp in the final image. The rest of the skin, I leave soft. I

28 EXTREME MAKEOVER TECHNIQUES FOR DIGITAL GLAMOUR PHOTOGRAPHY

1-45. The unretouched image.

1-46. Gaussian Blur has been applied
and the first stage of erasing has been
completed.



really like the soft-focus effect—it’s kind of idyllic.
“Next, I change the opacity of the Eraser tool to 70 percent and I

bring the brush size down to about the size of her pupils. I want to erase
and sharpen the eyes and all the areas surrounding them, following the
line of the eyes, eyelashes, and eyebrows. I also touch the tip of the nose
and the line of the lips—all without sharpening the surrounding skin
tones.

“After making the brush size a little bit larger, I can go in and hit some
of the hairs. I want the viewer to be able to count some of the hairs, be-
cause I want the overall impression of the image to be that it’s very, very
sharp—even though it contains huge areas of soft focus, like the skin and
the background, which is completely softened. Parts of her clothes, those
with detail especially, also need to have their sharpness restored to give
the image a realistic look. The parts of the image you’d expect to be sharp
should be sharp.

“My next step is to flatten the image. Then, I go to Image > Adjust-
ments > Curves and bump up the contrast—darkening my darks, and
brightening the skin tone. Next, I go to Image > Adjustments > Color
Balance and tweak the color. In these images, I increased the blue slightly
and took out a little red. Now, I’m happy.”

1-47. The final image in this series
shows how the background was made
to fit the image—dark to one side,
bright and soft on the other. This was
done with the Clone Stamp tool and
softening with the Gaussian Blur filter.
The background should complement
the subject and not distract viewers
from her.



Brenda Lee is a classic example of a beautiful woman who lacked
self-confidence. You can see from her “before” picture (image 2-

1) that she is naturally beautiful. She is also a mother of two children who
keeps extremely fit, dresses stylishly—and when modeling, she now ex-
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2. Brenda Lee

2-1. Brenda Lee as she arrived at the studio. 2-2. This is the original capture of Brenda Lee after makeup.



udes an air of confidence. She is a good example of how photographs
can help a subject attain a more positive self-image.

Makeup

Brenda Lee’s makeup was applied using the principles covered in chapter
1. At the conclusion of her makeover, image 2-2 was created. This was the
starting point for postproduction enhancement.

Postproduction

To refine this image, Jerry started off using the Patch tool, which is a
great tool to use when you want to preserve the integrity of the skin.
Using the Patch tool, you simply enclose a problem area that you want
to correct, then use this selection to isolate an area of “good” skin to re-
place the “bad” skin. Targets for this work (as well as for work with the
Clone Stamp tool) are identified in image 2-3.

In image 2-4, areas where the Clone Stamp tool was targeted are indi-
cated. A 30 percent opacity setting and 68 percent flow setting were used
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2-3. Areas where the Patch and Clone Stamp tool were used
to refine the look.

2-4. Areas where the Clone Stamp tool were used to smooth
the skin and reshape the hips.

Using the Patch tool,

you simply enclose a

problem area that you

want to correct . . .



with the Clone Stamp tool to blend any area of skin where the tonal val-
ues needed to be more even. The Clone Stamp tool was also used at 100
percent opacity to narrow Brenda Lee’s hips. Jerry did this by cloning
areas of the background onto the edges of her hips—almost as if he was
using an eraser to eliminate elements he didn’t want seen.

Image 2-5 shows the results of using the Patch tool and the Clone
Stamp tool together to create a soft, unblemished skin treatment—and to
remove unwanted elements like the light in the background. Image 2-6

shows the flattering differences in Brenda Lee’s right arm and hip, which
were reduced by subtle use of the Clone Stamp tool.

The next step was to duplicate the background layer and apply the
Gaussian Blur filter (Filter > Blur > Gaussian Blur) at a radius setting of
20 pixels to soften the entire image and to subdue the background into
blended tones. After applying the Gaussian Blur filter, Jerry chose the
Eraser tool and set it at 30 percent opacity and 60 percent flow, with a
large, soft-edged brush. On the duplicate layer, the Eraser was moved
over the entire image in a circular motion, starting just outside the

2-5. The image after the application of the Clone Stamp and
Patch tools to smooth the skin.

2-6. The image after the application of the Clone Stamp tool to
reshape the silhouette.

Jerry did this by cloning

areas of the background

onto the edges of her

hips . . .
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perimeter of the body and then on the body itself. Then, another pass was
made with the Eraser tool at 75–80 percent opacity, erasing specific areas
of the image where sharpness needed to be retained in order to maintain
the realistic look of the image (Jerry calls this the “details pass”). The re-
sults of this are seen in image 2-7.

At this point, the image was flattened and a Save As (File > Save As)
was performed. The file was then closed and re-opened.

Next, the Dodge tool (at an exposure setting of 8 percent) was used
to lighten the area under Brenda Lee’s eyes. Then, using the Dodge tool
at a 10 percent exposure setting, the whites of the eyes were lightened to
clear up blood vessels. The same setting and tool were also used to add
a bit of light on the pupil of the eye, dodging around the iris with a very
small brush. When the whites of the eyes are “cleaned up” in this way,
they become more seductive. The eyes are always the focus of any por-
trait, so this special attention to the detail in and around them is necessary
(image 2-8). To complete the image, the exposure of the Dodge tool was
then changed to 20 percent to lighten the entire background.
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2-7. The image is selectively softened using the Gaussian
Blur filter.

2-8. The eyes are brightened using the Dodge tool.

When the whites of the

eyes are “cleaned up” in

this way, they become

more seductive.



Image 2-9 shows the final version of Brenda Lee’s high-key swimsuit
shot. Notice that the background has been dodged, creating a high key
image. The soft shadow surrounding her body was left intact to create
depth in the image.
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2-9. The final version of Brenda Lee’s
high-key swimsuit shot.



2-10 (above). Here is another image of
Brenda Lee. This is the “before” shot.

2-11 (right). This is the final image,
where steps similar those used in the
previous image were used to enhance
the final portrait.

A LETTER FROM BRENDA LEE

I have never been one for getting my picture taken. For as long as I can remem-

ber, I never liked to look at pictures of myself. I was always picking out my

flaws.

I met you a few years ago, and I remember you telling me I should let you

photograph me. For months, I was skeptical, but after running into you a few

more times, I finally committed to a photo shoot.

When I viewed the pictures that you made of me, I was ecstatic. Your lighting,

camera angles, and brilliant, off-the-wall location ideas turned one picture-shy

little girl into a confident, beautiful woman pursuing a career in modeling.

Thank you so much for everything.



Cecilia is a middle-aged woman whose goal is to preserve her at-
tractiveness and style. When she came to Jerry’s studio (En-

chanted Memories in Upland, CA), he decided to create an elegant, classy
glamour image, using gold tones and highlighting her good figure and
attractiveness. Jerry envisioned a final image where Cecilia was so gor-
geous that she “melted” into the gold lamé background beneath her.

Makeup

Cecilia’s makeup was applied using the principles covered in chapter 1.
At the conclusion of her makeover, image 3-2 was created. This was the
starting point for postproduction enhancement.

Postproduction

The first step was to use the Clone Stamp tool to define the shape of Ce-
cilia’s torso. With the opacity set to 100 percent, adjacent background

36 EXTREME MAKEOVER TECHNIQUES FOR DIGITAL GLAMOUR PHOTOGRAPHY

3. Cecilia

3-1. Here is the “before” photo, taken
when Cecilia first came to the studio.

3-2. This is the original capture of
Cecilia after makeup.



areas were copied onto the area beneath Cecilia’s bustline, thereby re-
moving some of her middle area for a slimmer look (images 3-3 and 3-4).

To soften under the eyes, the areas between the nose and the mouth,
under the neck, and the skin visible on Cecilia’s leg, the Clone Stamp
tool was applied at 30 percent opacity and 80 percent flow (image 3-5).
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3-3. The areas where the Clone Stamp tool will be applied to
sculpt Celicia’s figure are indicated.

3-4. Here, you can see the area beneath the bust that was re-
duced using the Clone Stamp tool.

3-5. The skin was softened using the
Clone Stamp tool.



After saving the previous step as a new file, the background layer was
duplicated. Working on the duplicate background layer, the Liquify filter
(Filter > Liquify) was opened and a brush with a diameter that fits the
area to be changed was selected. Using the Forward Warp tool (to selec-
tively push areas of image data, almost as though you were fingerpaint-
ing) and the Twirl Clockwise tool (to selectively rotate areas of image
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3-6 (left). Liquify’s Forward Warp tool
and Twirl Clockwise tool were used to
distort the background.

3-7 (below). With the distortion re-
moved, this is the final image.



data) the background was manipulated to distort it and create a “melted”
look. Jerry varied the brush size and changed the intensity of the effect
until he had created the desired effect (image 3-6). Unfortunately, the
application of these tools caused areas of Cecilia’s body (note her right
and left elbows) to become distorted.

To reshape her elbows and any other areas where the distortion was
unwanted, Jerry used the Eraser tool on the duplicate background layer.
This restored the original (undistorted) image data from the original
background layer below (image 3-7).
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During the summer of 2003, I contemplated the idea of maybe

visiting a photographer. I had just lost some weight and was

feeling a little better about myself than I had in a long time—

although my way of dressing would never have reflected that.

I covered myself with loose clothes and oversized pants. No

one could actually tell that there was a figure underneath all

that clothing. Still, I felt it was time to celebrate the new me.

On the day I entered Jerry D’s studio, I walked in and listened

to the music playing while I scanned all the beautiful photos

before me. I immediately felt this nervous feeling come over

me. I was feeling intimidated and unsure—not about Jerry’s tal-

ent as a photographer, but I just didn’t think I could look like

those images that I saw in his studio. Jerry, who welcomed me

into Enchanted Memories Photography, greeted me and I was

shown different photo albums of many people who had passed

through the doors of his studio. There were formal photos,

wedding and family photos, group photos—just an endless

array.

On the day of the photo shoot, I arrived still nervous and un-

sure. I brought a varied wardrobe and took a series of shots;

some formal, some fun and whimsical, and even some sexy

shots. I was nervous, but I found myself becoming increasingly

confident, following Jerry’s instructions with a new-found en-

thusiasm and confidence. It sure was a different experience as

opposed to those mall photo sessions I was used to. At the end

of my shoot, I left Jerry’s studio feeling confident. I was feeling

good about myself—and for a little while I thought, “Hey, I

guess I could look like those people in his studio.” I would have

to wait and see.

On the day my photos were finally ready for viewing, I was

thrilled. “Who is that?” is what I remember saying to Jerry. It

was me—the real me. I was very impressed—not only with the

results of Jerry’s work, but by Jerry’s professionalism. He was

funny at times, comforting during the moments when I was un-

sure, understanding, and very patient. In the end, I couldn’t

wait to show off my photos to my family and friends. They were

beautiful and tasteful.

Here I am four years later, and I still find myself staring at

the photographs Jerry created. I have a 16x20 photo of myself

hanging in my home and I get compliments all the time. I refer

all my friends and family to Jerry D. He is really a master of

photography and fine art. That is what his work is: fine art.

When in the area, I walk past his studio and stare at the photos

on display through the glass and I am tempted to book another

session. I couldn’t imagine going anywhere else if the need

were to arise for more photographs in the future.

My sincerest appreciation and admiration to you, Jerry D.

A LETTER FROM CECILIA



Barbara was looking to hang some attractive portraits of herself in
her home. She was a word-of-mouth referral from one of Jerry’s

other clients, who told Barbara that Jerry could make beautiful portraits.
After conferring with Barbara, Jerry decided to create a large portrait

to be hung in her bedroom—something that would look classy and ele-
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4. Barbara

4-1. This is Barbara and you can see from her “before” snap-
shot that she is a very attractive woman.

4-2. This is the original capture of Barbara after makeup.



gant and not feature too much nudity. It was to be something sexy and
attractive that she would feel comfortable displaying.

Makeup

Barbara’s makeup was applied using the principles covered in chapter 1.
At the conclusion of her makeover, image 4-2 was created. This was the
starting point for postproduction enhancement.

Postproduction

In the “before” example (image 4-2) the satin material draped over a pos-
ing block looks pretty average; that’s something that will need to be ad-
dressed. Also, notice that Jerry did not bother to position the light
outside of the frame; he knew it could easily be removed in retouching.

The first steps taken on this image were with the Clone Stamp tool,
which was used to remove unwanted objects (like the light) and to soften
any lines on her face and body. Image 4-3 shows how the portrait looked
after removing these unwanted elements.

4-3. The Clone Stamp tool was used to
remove unwanted elements.

It was to be something

sexy and attractive

that she would feel

comfortable displaying.



Next, the background layer was duplicated and the Gaussian Blur filter
(Filter > Blur > Gaussian Blur) was applied to it using a radius setting of
20–30 pixels (image 4-4). With the Eraser tool set at 30 percent opacity
and 60 percent flow, a large, soft brush was used to reveal the underlying
layer, restoring some sharpness from head to toe and slightly beyond the
perimeter of the body. Switching to an 80 percent opacity setting, the
Eraser tool was then used to restore sharpness in the facial details (like the
lips, eyes, and eyebrows), as well as the fingernails, hair, rings, toenails,
and possibly clothing. The result is the look of baby-soft skin—but with
sharp details in the critical areas. Image 4-5 shows the photograph at the
conclusion of this process.

Finally, Jerry flattened the image and used the Burn tool to darken the
edges to create a vignette around the portrait (image 4-6). Image 4-7 is
the final version, in which Jerry included his signature on the final print—
it’s in red near the bottom of the frame. The final print, which hung in
Barbara’s bedroom, was a 30x40-inch, canvas-mounted image.
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4-4. The Gaussian Blur filter was applied to soften the image. 4-5. Sharpness was selectively restored using the Eraser tool
to reveal the underlying original background layer.



4-6. The edges of the image were vignetted using the Burn
tool.

4-7. The final image with Jerry D’s signature subtly added near
the bottom of the frame.

4-8 and 4-9. Here are
two additional im-
ages Jerry created for
Barbara’s glamour
book, a product he
often prepares for
his clients (see next
page). Jerry even
gave one of the
images a painted
look after the
manipulations were
complete.



During each thirty- to sixty-minute session, Jerry will routinely

make over two hundred image captures. He’ll also incorporate

different wardrobe changes, props, and backgrounds to vary

the session. The object, so far as Jerry’s business is concerned,

is to produce a large wall portrait that captures the immortality

of the person’s beauty and youth—the essence of the person in

one large image designed to be hung in the home. However,

his clients normally like so many of the photos from the ses-

sion that he ends up making books or albums, called glamour

books, that incorporate many of the different poses made dur-

ing the session.

Two such books are pictured in images 4-11 and 4-12. Jerry’s

skill as an album designer for his wedding business makes him

the ideal architect for these glamour books, which make great

gifts for grooms, boyfriends, and loved ones, but are usually

created mainly for the client herself. In fact, if a client feels like

she needs to have someone to give the book to before order-

ing, Jerry says to them, “Do this for yourself as a record of this

time in your life. Then, when you decide to, you can share it

with someone you love.”

The glamour books usually feature twenty pages and incor-

porate roughly thirty to thirty-five images. Each page is de-

signed in Australian photographer Martin Schembri’s You

Select It (www.youselectit.com), an album-design template pro-

gram. Sandis Leather then binds the books from prints that

Jerry makes in his studio using his Epson 9600 printer.

JERRY’S GLAMOUR BOOKS

4-11 (above). A two-page spread from
Rosi’s glamour book (see chapter 14).

4-12 (left). Another variation of the
glamour book. This one was created
for Kami.



E liysia visited Jerry’s studio when she was seven months preg-
nant. She wanted Jerry to produce a glamorous, sexy portrait of

herself for her home.

Makeup and Lighting

Eliysia’s makeup was applied using the principles covered in chapter 1. At
the conclusion of her makeover, image 5-2 was created. This was the start-
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5. Eliysia

5-1. This is Eliysia as she arrived at the studio—seven
months pregnant!

5-2. This is the original capture of Eliysia after makeup and
with the use of very soft lighting.



ing point for postproduction enhancement. The lighting for this image
is soft because a softbox was used as the main light, a reflector was posi-
tioned beneath Eliysia’s face, and a mild fill light was added to her right.
The reflector was used directly beneath the softbox to help fill in the lines
on her face.

Postproduction

The first step was to use the Clone Stamp tool at 30 percent opacity and
60 percent flow to remove any minor blemishes, laugh lines, veins, and
areas of unequal density. Setting the Clone Stamp tool to a low opacity
makes it possible to make subtle changes that are softly blended. Like an
artist, Jerry may brush over an area several times to make it look seamless.
These settings make retouching done with the Clone Stamp tool virtually
invisible. Image 5-3 shows areas that needed to be retouched; image 5-4

shows Eliysia’s portrait after the Clone Stamp tool was applied.
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5-3. Targets for retouching using the Clone Stamp tool. 5-4. The image after retouching with the Clone Stamp tool.



The Gaussian Blur filter (Filter > Blur > Gaussian Blur), at a 10 pixels ra-
dius, was then applied to a duplicate of the background layer. The effect
is very slight because she did not need major softening (image 5-8; next
page). Then, the Eraser tool was used on the duplicate background layer
to restore detail to the eyes, eyebrows, tip of the nose, lips, hair, and
fabric (image 5-9; next page). Note that the sharpness is not restored
along the bridge of the nose; restoring it to just the bottom edge of the
nose is all that is needed to give the illusion that the entire nose is sharp.

Image 5-10 (next page) shows the first “final” image that Jerry created
from this session—about four years ago. He completed it using the Burn
tool to shadow the edges of the arm, adding depth and a slimming effect.
He also increased saturation using the Curves (Image > Adjustments >
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Noses come in all sizes and shapes—and most people aren’t

crazy about their own nose, even if it’s a shape and size that

most people would consider perfect. All people have a puffy

area adjacent to the side of the nose. This often causes the

nose to appear wider and even odd in shape. Instead of admir-

ing the straight line of the nose, what we often see is the fatty

tissue on the frontal plane of the face above the nostrils. Also,

it should be noted that no one’s nose is completely straight.

Bumps and irregularities of the nose’s structure make the

straight line of the nose difficult to see.

To solve these problems, Jerry clones from the lighter part

of the cheek near the nose, using the Clone Stamp tool to re-

place shadow with highlight. To straighten the highlight on top

of the nose, Jerry evens out the shadow line so that it becomes

consistent from the tip of the nose to the bridge of the nose.

5-5. The original image of Eliysia as she ar-
rived at the studio.

5-6. Eliysia’s nose before retouching has a
small bump.

5-7. Retouching smoothed and straight-
ened the nose.

THE FINE POINTS OF FACIAL RESHAPING



5-8 (top left). The Gaussian Blur filter was ap-
plied to a duplicate background layer.

5-9 (top right). The Eraser tool was used to re-
store sharpness in critical areas.

5-10 (left). A “final” version of this image cre-
ated several years ago.



Curves) and the Brightness/Contrast (Image > Adjustments > Bright-
ness/Contrast), which controls the blacks and the whites, sometimes
eliminating some of the image detail.

The version of Eliysia’s photo seen in image 5-11 was completed more
recently. The differences between the two “final” images reflects Jerry’s
changing tastes and a refinement of his skills. You will notice that the
more recent version is a little lighter and slightly softer than the prior ver-
sion. Jerry feels the eyes are stronger, as well. Additionally, much of the
image detail in the blacks is restored in this version.

5-11. A “final” version of this image
created more recently reflects Jerry’s
changing tastes.



These before and after images of Eva are quite remarkable. They were shot in a single af-

ternoon and the Photoshop retouching work was done very quickly. In each of the two ex-

amples, the first and last versions of the image have been included so you can see the

drastic differences.

BEFORES AND AFTERS: EVA

5-13 (above) and 5-14 (left). Eva’s
image before and after postproduc-
tion enhancements.

5-12. Eva as she arrived at Jerry D’s
studio.



5-15 (right) and 5-16
(above). Eva’s image
before and after
postproduction
enhancements.



Jerry has known Peggy Lynn for over twenty years and watched her
grow from a shy twenty-year-old into a confident woman who is not

afraid to deal with her insecurities. She has made all the requisite changes
in her life to add to her personal happiness. During this studio session,
Jerry wanted to create something that would reflect her self-assurance
and show her beauty. The final portrait was to be hung over the bed in
her master bedroom.

Makeup

Peggy Lynn’s makeup was applied using the basic principles covered in
chapter 1. At the conclusion of her makeover, image 6-1 was created.
This was the starting point for postproduction enhancement.
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6. Peggy Lynn

6-1. This high-key glamour pose is the original image in the series. Jerry created
it using a large softbox overhead, a small fill light to Peggy Lynn’s left, and a
silver/white reflector for additional fill light.

Jerry wanted to create

something that would

reflect her self-assurance

and show her beauty.



Postproduction

The first thing Jerry noticed when he went to work on this image was the
twisted bra strap on her shoulder. If he couldn’t fix that, then he would
have had to select another photo. (Note: Of course, it would have been
much easier to fix this problem when the image was being made, but he
didn’t notice it then.) At this stage, Jerry also isolated a number of areas
where he needed to use the Patch tool to smooth the skin while preserv-
ing its texture and tonality. Using the Clone Stamp tool over such large
areas would have been a mistake; it can give the skin a plastic look when
applied in this way. Image 6-2 shows the areas of concern.

Image 6-3 shows the game plan for fixing the twisted strap using the
good strap. Jerry began by duplicating the image (Image > Duplicate).
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6-2. Areas targeted for enhancement
were identified.

6-3. The game plan for fixing the
twisted bra strap.
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6-4. After duplicating and flipping the image, the untwisted strap was selected and dragged back into the original image.

6-5. The replacement bra strap was positioned.



He then reversed (flipped) it horizontally (Image > Image Rotation >
Flip Canvas Horizontal). Using the Lasso tool, he then selected the good
strap on the reversed image (the duplicated image). Using the Move tool,
he dragged the selected strap back to the original image file, as seen in
image 6-4.

The imported bra-strap image was positioned in the same area as the
twisted strap, then the Free Transform function (Edit > Free Transform)
was used to rotate and scale the object (image 6-5). Holding the Shift
key down constrains the proportions as you drag on a corner handle to
resize the object. Once in position, some fine-tuning with the Clone
Stamp tool was necessary to perfect the effect. Image 6-6 shows the strap
replaced and the area around it blended to perfection. Further blending
will occur when the Gaussian Blur filter is applied in the next step.

At this stage, a duplicate background layer was made and the image
was blurred using the Gaussian Blur filter (Filter > Blur > Gaussian Blur)
at a radius setting of 20 pixels (image 6-7).
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6-6. Blending with the Clone Stamp
tool made the replacement strap blend
seamlessly with the image.

6-7. The background layer was
duplicated and the Gaussian Blur filter
applied.



Using the Eraser tool with a large brush size and a minimal opacity
setting (30 percent on the first pass), Jerry loosely rotated the tool in a
circular motion, extending the motion just outside the subject area, as
shown in image 6-8. This erasing procedure revealed the original under-
lying image layer and restored a soft sharpness to select areas of the image.
The entire image, with the exception of the background, was lightly
erased on the first pass.

A second overall pass was then made with the Eraser tool at 30 percent
opacity (and 60 percent flow). With this technique, the skin remains baby
smooth and all flaws are forgiven. Next, the details of the face required
a third pass with a very small brush set to 70 percent opacity. The purpose
of this third pass is to restore critical sharpness in small areas we expect
to be perfectly focused—such as the eyes, the hair, jewelry, lips, tip of the
nose, and clothing. The result of this process is seen in image 6-9. Flatten
the layers and you are ready for the final manipulations.

56 EXTREME MAKEOVER TECHNIQUES FOR DIGITAL GLAMOUR PHOTOGRAPHY

6-8. The Eraser tool, at a low opacity,
was used over the subject area.

6-9. Subsequent passes with the Eraser
tool restored additional sharpness,
particularly in critical areas (eyes, lips,
etc.).



Next, the Clone Stamp tool was used to blend and soften any remain-
ing uneven highlights and shadows, as seen in image 6-10. The final step
was a minor adjustment in the Curves (Image > Adjustments > Curves)
to bring up the white tones and bring down the black tones for a slight
increase in contrast (image 6-11). This is a personal preference of Jerry’s;
he believes a little added contrast creates heightened visual interest.
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6-10. The Clone Stamp tool was used
to blend away any remaining uneven
areas.

6-11. Adding a little contrast boost was
the final step.



Image 6-12 shows the final image. Notice how the tulle material in the
background has been left very soft in the final version.
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6-12. The finished portrait of Peggy
Lynn.



I can remember my first meeting with Jerry D like it was yester-

day. Only twenty years old, I was very shy and reserved with

low self-esteem. I never wanted to be the subject of anyone’s

attention because being the center of attention was usually as-

sociated with being teased or criticized in school where I grew

up—on a ranch in rural Minnesota.

Knowing this, it would not surprise you that I did not want

volunteer to be a model in beauty college that day back in

1979. The special guest hairstylist that day was there to

demonstrate make-overs and he referred to himself as Jerry D.

I can still remember the way his eyes roamed the room once

over and once back with all the girls eager to be the subject of

his work raising their hands and about to climb out of their

seats. Jerry D was one of those people you meet that you knew

had something special about him. He prided himself in proving

to any audience that he could deliver excellent, creative work.

There were many pretty girls in beauty college, and I was

sure he’d pick one of them. I did not raise my hand because I

was surely not pretty enough. When Jerry pointed at me, I was

utterly shocked, thinking he had made a mistake and that he

was pointing at someone else. As I looked around the room, all

eyes turned to me. I can remember seeing the look on the other

girls’ faces. I just wanted to hide.

I entrusted him with my whole look. He cut my hair, colored

it, and even applied makeup. If he’d had clothing available, I’m

sure he would have changed that, too. It was a beautiful trans-

formation from the inside out. I felt like a new person that day

as Jerry D revealed his finished product to the class.

I don’t think anyone had ever spent the time to help me with

my image or to make me feel beautiful. It was empowering to

see that as my self-esteem began to increase, I was climbing

the social ladder of acceptance.

Jerry D took a mousy blonde girl and turned her into a viva-

cious redhead, now able to captivate a room with confidence—

and captivate the room is what I did that afternoon twenty-

seven years ago.

After that experience, it had been years since I had seen or

heard about Jerry. My recollection was brought back as I was

browsing through some business cards on display at a local

bakery. I was ordering my wedding cake that day and was

browsing the store. I picked up his postcard-sized business

card with all these sample photos when I spotted his name on

the bottom corner. I said to my fiancé as I placed the card in my

purse, “I know this guy and he was an excellent hair stylist; I am

sure he’s a great photographer.” I went on to say how excited

I was to give him a call. Though I wasn’t interested in hiring a

top-notch photographer for my wedding at the time, I was anx-

ious to see his work.

When I called Jerry, he remembered me right away and in-

vited me to see his studio in Upland, CA. I think I was more

eager to see him than his studio because it’s always nice to see

someone from years ago and spark fond memories—but I was

so stunned when I entered his studio that summer afternoon.

I was truly taken aback by the creativity, originality, and per-

sonal touch he had given to all his photos. I remember just gaz-

ing at the huge photos in awe. They were beautiful keepsakes,

and a treasure for those who could claim them as their own. I

did not have the extra money to spend on these type of photos

for my upcoming wedding, but at that time I decided I would

rather have one of Jerry D’s photos than three-hundred photos

done by a less gifted photographer. And so my photo experi-

ence began.

My next memorable experience started with the engage-

ment photo shoot. The locations were at various local outdoor

spots, yet taking these photos became a very personal and pri-

vate experience for my fiancé and me. As evident in our pho-

tos, Jerry did a wonderful job at capturing the love and passion

my fiancé and I had for each other.

The process then continued with going back into the studio

to select our photos and design our engagement album. Dur-

ing that time, Jerry got a chance to get to know Bill and me,

and he was able to sense the uniqueness of our relationship,

which enabled him not only to give us timeless photos, but re-

minded us of how lucky we were to have found each other,

strengthening the bond we already had. To this day, those who

view our photo album react the same way I did the first time I

saw Jerry’s work. Most say that it is, by far, the most beautiful

wedding album they’ve seen.

Though my wedding photos and engagement photos were

an awesome and treasured experience, my most fulfilling

photo experience was when I went back to the studio two years

later to do some intimate photos of myself. Though I said that

I was doing the photos for Billy, who is my best friend as well

as my husband, if you want to know the truth, I really just

wanted to do some photos for myself. I had decided that I

needed to capture this fading thing known as youth, and if any-

one could capture it, I knew Jerry could.

So I called for an appointment, knowing that it would require

me to be utterly vulnerable and exposed. I did all I could to get

ready for the photo shoot: I lost fifteen pounds and tried to be

in the best shape possible, but everyone knows how hard it is

to stay on a diet and regular exercise plan. I decided that I was

not at my best, but that it would have to do.

I enjoyed picking out some sexy lingerie and bringing a few

things to the studio. Yet, truthfully, I was horrified that the
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He prided himself in proving

to any audience that he could deliver

excellent, creative work.



camera would show all my imperfections. The camera can be

relentlessly honest. However, Jerry made me feel very comfort-

able, and after taking a few photos I was able to relax and enjoy

the experience. Jerry knew that I had always been overly critical

of my appearance and so he helped me to feel more confident.

He was able to see the best in me and it helped me to feel beau-

tiful from the inside out.

I will never forget when he told me that true beauty comes

from the inside and is expressed from within. I was almost em-

barrassed as I pondered the reality of this statement and ques-

tioned whether I could practice this in my daily life. Was I yet

to have another turning point in my perception of myself at age

forty-six? I thought to myself how ridiculous I had been to have

concentrated only on my external appearance for the photo

shoot. I started to ask myself questions like, “Do you feel beau-

tiful inside? Do you express beauty from within? Do you believe

you are a beautiful person no matter what you look like or what

kind of hair day you’re having?”

Honestly, I felt very small as I contemplated all of these

questions. I began to focus on the times that I did feel beautiful

on the inside, and I made a decision that day to work on feeling

beautiful from within as much as I did on just looking good.

I am grateful for my friend, stylist, and photographer who

challenged me to see the best in myself. Jerry D saw the best

in me twenty-seven years ago, and even now at the age of forty-

seven. I am the proud owner of portraits that many people only

dream of having. Although some of my portraits do have sex-

ual undertones, they are done with class and artistically define

the essence of pure romance and sensuality. It is my best hope

that other women find Jerry D (or someone like him), who is

able to create, for them, their own masterpieces portraying the

best in them and that they will feel as beautiful as I do when I

see my photos. I know that this is one of those “girl things”

that men also appreciate. It does not surprise me that Jerry

named his studio “Enchanted Memories.”

6-13. Here is an engagement photo that Jerry did of Peggy Lynn and Bill.

I am grateful for my friend, stylist,

and photographer who challenged me

to see the best in myself.



Sally is a mother and a successful businesswoman. She came to
Jerry because, while successful, she wanted to feel more glam-

orous. Sally used the photos Jerry did of her to inspire her to begin work-
ing out and set new goals to create a new body and a new mindset.
Within the last two years she has lost weight, works out, kickboxes, and
overall, looks fantastic.

Image 7-1 shows Sally a few minutes after entering Jerry’s studio. His
idea was to create a painting that could hang in her house—something
that would not look like a photograph. It is important to individualize the
session, gearing it toward each client’s expectations. Jerry often discusses
in great detail the type of image the client would like to see hanging in
their home. Such discussions are an important ingredient in the creation
of the final image. He will even ask detailed questions about their home
décor to get a better feel for where the image will be displayed.

Makeup

Sally’s makeup was applied using the basic principles covered in chapter
1. At the conclusion of her makeover, image 7-2 was created. This was the
starting point for postproduction enhancement.

7. Sally

7-1. This is how Sally looked when she
first arrived at Jerry’s studio

WHY CLIENTS WANT WALL PORTRAITS

In the days of the Renaissance, people would contract artists

to create large wall portraits for their homes. These paintings

were a record of their lives and, in some way, a form of im-

mortality. Just as the paintings that once hung in someone’s

villa are now in museums, and we all enjoy and treasure them

as works of art, your subject’s beauty can be preserved for

people to enjoy. It is Jerry’s belief that, as photographers, we

should create beautiful works of art to be hung in people’s

homes—and even if someone doesn’t know who you are, they

can enjoy it. He counsels people to decorate their home with

personal art depicting themselves and the people they love.

With this in mind, his goal in every session is to make large

prints for those walls.

7-2. This is the first image in the series,
with no retouching of any kind.



Postproduction

Ninety-nine percent of women want to be thinner. Therefore, the first
step in enhancing this image was to reshape her body (image 7-3 shows
the areas targeted for this process). Using the Clone Stamp tool set at 100
percent opacity and flow, Jerry cloned areas of the background onto the
edges of her body and arms, virtually removing her right arm from view
and greatly slimming her left arm. Under her left elbow, the fabric in
which she is draped was also cloned over with image data from the back-
ground, making her silhouette substantially thinner. Image 7-4 shows the
slimming results. For the back side of her left arm, Jerry cloned an area
from her back onto the arm itself, extending the back and reducing the
width of the arm.

With the Clone Stamp tool set to 30 percent opacity and 65 percent
flow, Jerry began eliminating all the little imperfections on her back and
face, evening out the tonality and resculpting the back and arms (image
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7-3. The areas targeted for enhancement. 7-4. The image after reshaping of the arms and drape.



7-5). Looking back to the original image (image 7-2), notice that the
curve of the spine is now radically different. This version is more painterly
and creates the illusion of a thinner and more naturally curving back. The
Clone Stamp tool defined the shape and contour in the back and arms.
Unfortunately, you can also see that the skin does not look finished or
even natural at the conclusion of this process. At this stage, however, it’s
more important that the shape be right.

Next, the background layer was duplicated. Jerry then blurred it using
the Gaussian Blur filter (Filter > Blur > Gaussian Blur) at a radius setting
of 20 pixels (image 7-6; next page). Using the Eraser tool at 30 percent
opacity and 60 percent flow, Jerry made a single pass around the body
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7-5. The Clone Stamp tool was used to
remove imperfections, resculpting the
back and arms, but it did not leave the
skin looking natural.



7-6. The Gaussian Blur filter was applied on a duplicate layer. 7-7. An initial pass with the Eraser tool set to a low opacity
restored some sharpness.

7-8. Another pass with the Eraser tool restored more of the
sharpness.

7-9. A final pass with the Eraser tool at 80 percent opacity
restored sharpness on the face, features, and clothing.



(working on the blurred duplicate layer) using a wide, soft-edged brush
(image 7-7). As you can see in image 7-8, with a second pass of the Eraser
tool at 30 percent opacity and 60 percent flow, the characteristic balance
of sharpness/softness began to appear. The final pass with the Eraser tool
was made at 80 percent opacity and 60 percent flow, using a much smaller
brush to reveal the sharp details of the face, features, and clothing (image
7-9). At this point the layers were flattened.

Next, the Curves function (Image > Adjustments > Curves) was used
to lower the black point and midtones, increasing the contrast and dark-
ness on the subject’s back (image 7-10).

Completing this image also called for selective dodging (lightening) and
burning (darkening). Jerry began with the Burn tool (set at 14 percent
exposure), choosing a small, soft-edged brush. With this tool, he traced
up and down the arms, the middle of the back, and the right side of the
body to build up density and form, much like a painter would enhance
the shadow areas to create a sense of depth (image 7-11). Then, Jerry
used the Dodge tool at a 28 percent exposure setting to lighten the hair
and fabric, bringing out detail. He used the same tool to enhance the
highlight on Sally’s buttocks (image 7-12).

At this stage, Jerry added noise (Filter > Noise > Add Noise) to the
image in order to create a slight amount of texture and add more realism
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7-10. The Curves function was used to
darken the shadows and midtones.

7-11. The shadow areas (boths sides
of the arm, the spine, and the curve of
the waist) were enhanced using the
Burn tool.

7-12. Highlight areas (hair, buttocks,
and the fabric) were enhanced using
the Dodge tool.



7-13. Noise was added to the image. 7-14. A vignette was created by using the Burn tool on the
edges of the frame.

7-15. The right half of the frame was selected with the Rectan-
gular Marquee tool, then Free Transformed.

7-16. The image after slimming with the Free Transform func-
tion and recropping.



to the portrait. He used a setting of 3.5 percent and selected the Uniform
setting (image 7-13). To create a vignette, Jerry also used the Burn tool
at 14 percent exposure around the edges of the frame (image 7-14).

Using the Rectangular Marquee tool, Jerry then made a selection on
which he would use the Free Transform function (Edit > Free Transform)
to further narrow her body (image 7-15). Image 7-16 shows the portrait
after Free Transforming and recropping.

After a final color balance (Image > Adjustments > Color Balance),
adding a touch of blue and reducing some red, we come to the final por-
trait, seen in image 7-17. Color balance is often very subtle at this stage
and is subject to personal tastes.

7-17. The final image after a slight ad-
justment to the color balance.



7-18, 7-19, and 7-20. Three outtakes from Sally’s sessions.



“Incredible.” The word echoed in my head as I stared down at

the beauty of the photo in my hands. I looked at Jerry in disbe-

lief as his face broke into a huge grin, “You like?” he said. How

could I possibly explain the jumble of emotions I was feeling as

I gazed down on what had to be the most beautiful piece of art

I had ever seen! Who would believe that just six months ago I

had been struggling with thoughts of worthlessness and sui-

cide after enduring a bitter divorce and an ever-more-bitter ex-

husband. Years of an abusive marriage had left me feeling

broken and struggling to regain my self-esteem.

The photo shoot had been a suggestion from a friend hop-

ing to distract me and clean me up a bit. I was reluctant be-

cause it had been months since I had been able to see myself

as even remotely attractive. The meeting with Jerry was com-

fortable, though, so I decided to give it a try. The day of the

shoot had me in a panic and I worried about my body, my

clothes, and how I would look on film. Armed with a bottle of

wine and my best friend in tow, I reluctantly walked into the

studio. Sensing my discomfort, Jerry immediately started the

music, got me a glass, and went over some of his ideas to get

my mind off the process. We started slowly—and gradually I

started to feel more comfortable. I was amazed at how easy

and how much fun it was! When we finished, I got dressed and

we started to browse through some of his photos on the com-

puter. He played with them a bit to show me the possibilities.

I was amazed and excited to see the final results!

I never expected to feel so emotional about viewing my pho-

tos, but what Jerry showed me was a completely different

woman from the one who walked in that door. The images in

front of me were nothing that I could have ever imagined—the

sexy, confident woman in these pictures couldn’t possibly be

me! I left in a daze, thinking of things I could sell in order to

purchase all the photos I wanted!

The experience was a huge catalyst in the changes I made in

the months that followed. I surrounded myself with my new

photos and they were reminders of how others could and did

see me. I was determined, more than ever, to pull myself out

of my depression and start living again. Although it’s been a

few years since then, I still look at those photos and feel grate-

ful for the experience—and I smile back at the woman whom

Jerry captured and brought back to life. Thank you, Jerry, for

making me feel beautiful and sexy again! I’m ready to shoot

again!

SALLY’S STORY

7-21 and 7-22. Here is Sally a year after her initial session with Jerry—and after much effort at self-improvement. She is now an avid work-
out diva, she has gotten into photography on a serious level, and she is exceptionally happy with life and with herself.



I had always wondered what it would be like to have profes-

sional pictures taken of myself and actually be happy with the

outcome. For so many years, I’d asked myself, “Why can’t I look

like those singers, models, and actresses in their photos?” They

always looked great, and I often wondered who these people

were that took such great photos.

While strolling through downtown Upland, I happened to

pass by Jerry D’s studio, Enchanted Memories, and was over-

whelmed by the fantastic photographs that were displayed in

his studio. Since my boyfriend and I were about to celebrate

our eight-year anniversary, I got the courage to make an ap-

pointment with Jerry to have some pictures taken of myself as

a gift for my boyfriend.

Before the shoot, Jerry told me that I could bring anything I

felt I would look good in, so I decided to take pictures in my

beautiful lingerie. I was a bit nervous about the idea at first,

but I knew Jerry was going to make me look great. I was also

nervous because I wasn’t sure about posing for the camera in

a way I was unaccustomed to. Yet, Jerry and his assistant were

so professional and made sure that I was as comfortable as I

could possibly be. After a few hours, I started to feel so glam-

orous—Jerry kept taking pictures of me left and right as if I

were a star. When he showed me how I looked on the back of

his camera, I couldn’t help but say “Wow!”—the pictures looked

so great. I could not believe I

was the one in those photos!

For the first time, I was able to

see that I can be sexy . . . and

proud of it, too.

After the photo session was

over, Jerry took me with him

into his computer room where

we downloaded the pictures

and I picked the two that I

liked the most. Those two pic-

tures already looked great to

me, but with Jerry’s expertise,

he made them look even bet-

ter! He enhanced the pictures

throughout and made me look

even more glamorous than before. I was so impressed with the

work that Jerry did. He made me feel lovely inside.

My boyfriend and I will be sure to see Jerry soon, because in

about a year we’ll be getting married—and I want nothing more

than for Jerry to be the one to capture the special moments of

my wedding. Thank you Jerry D! You’re the best!

A LETTER FROM FROM WENDY

7-23. Wendy when she arrived
for her session.

7-24. An image of Wendy from her session with Jerry.



G ina is a mother of three who is on her own and works hard at
keeping up her appearance. Gina has a skin disorder over her

entire body, causing a loss of pigmentation in certain areas. One of the
things Jerry wanted to do was to even out Gina’s skin tone. He also
wanted create photos that looked like paintings.

8. Gina

8-2. This is the first image in the se-
ries, with no retouching of any kind.

8-1. This is the original photo taken
when Gina arrived at Jerry’s studio.



Makeup and Pose

Gina’s makeup was applied using the basic principles covered in chapter
1. At the conclusion of her makeover, image 8-2 (previous page) was cre-
ated; Jerry decided on a three-quarter length semi-nude rendering of
Gina. This was the starting point for postproduction enhancement.

Postproduction

Jerry discerned that evening out Gina’s skin tone would be a major part
of the retouching process. To do this, he used the Patch tool. This tool
allows you to sample a “good” area of skin that is of similar tonality to
the “bad” area you want to conceal (these two areas do not necessarily
have to be adjacent to each other), then automatically blend on the
“good” skin to conceal the problem area. Image 8-3 shows the main areas
that Jerry first retouched.

The Clone Stamp tool was then used to help blend the tonality of the
skin that was retouched in the prior step, making it look completely nat-
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8-3. The Patch tool was used to blend away some of the un-
even areas on Gina’s skin.

8-4. The skin was further blended using the Clone Stamp tool.



ural. Jerry used a large-diameter brush at a low opacity for the blending
of both large and small areas (images 8-4 and 8-5).

At this point, Jerry went to File > Save As and renamed the file. He
then closed the current file and opened the new, renamed one before
continuing on with the postproduction. This will simplify the use of the
History Brush later in the process.

Working on the renamed file, Jerry applied Nik’s Midnight Sepia filter
(a third-party filter available at www.niksoftware.com). This filter gave
the image an overall look of softness and warmth, as well as a somewhat
mysterious flavor, as seen in image 8-6.

Jerry next selected the History Brush. He chose a soft-edged brush
set at 16 percent opacity and a flow of 65 percent. Using this, Jerry began
to selectively restore details from the image as it appeared before the Mid-
night Sepia filter was applied, bringing back the sharpness and detail in
the eyes and facial details, the hair, and the highlights that he wanted to
accent throughout the frame. On the background, Jerry used the History
Brush to restore some of the original color. (Note: The History Brush al-
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8-5. The final, combined result of
smoothing with the Patch and Clone
Stamp tools.

8-6. Nik’s Midnight Sepia filter was applied to the image. 8-7. Using the History Brush, Jerry selectively restored detail.



lows you to paint data from a different history state onto your current
image. Go to Window > History to view the history states for your image.
In this case, Jerry painted unfiltered image data back onto the filtered
image, selectively removing the effect of the Midnight Sepia filter.) The
effect of this process is seen in image 8-7 (previous page).

To complete the image, the Burn tool was used to darken a few of the
highlights. It was also applied along the edges of her body to provide
more contour and depth. Image 8-8 shows the final portrait of Gina.

8-8. The final image of Gina.



There are countless ways to accomplish the same result in Pho-

toshop. There are quick, efficient ways and other ways that

aren’t so fast. “Speaking for myself,” says Jerry, “I know I can

easily get overwhelmed with all the techniques and tools that

are available. It’s as if someone made a very complicated map

with a hundred different ways to get to the same destination;

it becomes very confusing as to what route to take. Sometimes

the more direct, simple path keeps us from getting lost. That’s

why I’ve tried to come up with a formula that makes it easier

for me to accomplish each task. Experts say we must repeat an

action two thousand times before it truly becomes a part of us.

For this reason, following certain formulas, time and again,

helps you to reach your goal more quickly—because the

process will become a part of you.

“Regarding Photoshop, I feel the best way

to get to know the software is to use all the

tools. Have fun with them—explore ones you

know nothing about and learn their possibil-

ities and limitations. Doing this nurtures

your creativity. This method of learning

through exploration doesn’t end with Photo-

shop; it can be used to get to know the full

spectrum of possibilities with all your equip-

ment. Take your camera, for instance. A lot

of times we get comfortable with one lens

and certain settings on the camera. Chang-

ing your focal length and using it in as many

situations as possible helps train your eye to

see in a different perspective. Get close up,

stand on a chair, lie down on the floor, or

even turn upside down. Whatever you do,

don’t stay stagnant. This also applies to stu-

dio lighting. Get to know what one light does

by setting it close to the subject, then plac-

ing it farther away—place it high as well as

low. Once you thoroughly understand what

that light can do, then you can add another.

One of my favorite things to do is use one

spotlight by itself and turn all the others off.

It’s an exercise that helps me to see how the

light will fall on and off a subject. Once you

know and understand how light behaves, it

can also help you with flash photography be-

cause you have a better understanding of

light. You can utilize even ambient light in

the same way.

“Cameras and equipment can get so com-

plicated at times that it becomes easy to lose

sight of what we want to accomplish. The

more complicated the process, the less feel-

ing goes into the image. When the process has been simplified,

practiced, and repeated, it becomes natural. This is when we

are able to bring forth the maximum in creativity and pull out

the most emotion from our images—because our minds aren’t

preoccupied with the technicalities of our equipment.

“Imagine you were asked to express your inner thoughts and

feelings in a foreign language. There would be so much detail

and nuance lost in translation. In photography, the camera and

computer software serve as your language. You must become

fluent in them in order to be able to fully express the feeling in

your images.”

A FEW WORDS ABOUT LEARNING YOUR CRAFT

8-9. This is an outtake from Jerry’s session with Gina.



When Katy walked into Jerry’s studio, he looked at her hair
and asked, “How long has your hairdresser been doing

your hair that way?” She replied, “About ten years.” Jerry’s answer was,
“Your hairdresser has stopped caring about you.” The difference was that
Jerry was seeing Katy with new eyes and her hairdresser was simply main-
taining a look (image 9-1). Therefore, the first thing Jerry did was to cut
her hair into a much younger and more stylish look.
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9. Katy

9-1 (left). This is how Katy looked
when she showed up at Jerry’s studio.

9-2 (right). The original image capture,
before postproduction enhancement.



Makeup and Pose

Katy’s makeup was applied using the basic principles covered in chapter
1. At the conclusion of her makeover, Jerry decided on a three-quarter
length semi-nude rendering of Katy. Image 9-2 shows the pose Jerry de-
cided to go with. By extending Katy’s arm in this pose and photograph-
ing her from a high angle, Jerry created length in her body. Having her
look up at him also stretched her neck to eliminate any excess folds of
skin. He also created an elegant S-curve in the composition of the pose.
This is one of the most pleasing shapes in all of photography and art; it
adds depth and dimension to the image. This was the starting point for
postproduction enhancement.

Postproduction

Using the Clone Stamp tool at 30 percent opacity and 65 percent flow,
Jerry chose a small, soft-edged brush to remove the harsh line from the
left underarm. He also removed the shadow above her right breast by
cloning light areas into it. Additionally, he worked under her eyes to re-
move the dark circles and age lines. He also worked the area around the
diamond necklace. The targeted areas for cloning are seen in image 9-3.

Continuing on with the Clone Stamp tool, Jerry noted areas to be
slimmed and removed (image 9-4). (Note: It is wise to separate the two
tasks of retouching and reshaping, even though the same tool is used.) In
this image, Jerry reduced the size of Katy’s waist, left arm area, right
wrist, right arm, and the fabric showing beneath the white tulle.
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9-3. The targeted areas for retouching with the Clone Stamp
tool.

9-4. The targeted areas for reshaping with the Clone Stamp
tool.

Photographing her from

a high angle created

length in her body.



Image 9-5 shows the portrait at the completion of the
retouching and reducing steps. Notice that, by cloning in
background areas, Jerry was able to significantly reduce
the overall shape and size of the body, accentuating the S-
shape and length of the arms. Also, notice the softly
smoothed areas of her face, which were also retouched.

Next, using his customary process, Jerry duplicated the
background layer and applied the Gaussian Blur filter (Fil-
ter > Blur > Gaussian Blur) to it at a radius of 22 pixels
(image 9-6). Using the Eraser tool set at 30 percent opac-
ity and 65 percent flow, he selectively revealed the under-
lying sharp details along the entire body and on some of
the background. He then made a second pass with the
Eraser tool at 30 percent opacity to reveal more detail
while retaining a soft look on the skin. Finally, a third pass
at the same setting was used to reveal sharpness around
the eyes, hair, stockings, shoes, fingernails, and jewelry
(image 9-7).

The Dodge tool was then applied at a 40 percent expo-
sure setting to give the image a high-key vignette, paying
particular attention to the gray areas at the top of the
image around her shoes (image 9-8).

After stepping back and examining the image once again, Jerry realized
the subject’s left shoulder was too big, so he decided to use the Clone
Stamp tool at 100 percent to further slim this area. Still not entirely sat-
isfied, he also adjusted the tonality of Katy’s body by burning in the left
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9-5. The portrait at the completing of
retouching and reshaping with the
Clone Stamp tool.

9-6 (left). The Gaussian Blur filter was
applied to a duplicate of the back-
ground layer.

9-7 (right). The Eraser tool was used
selectively on the Gaussian Blur layer
to reveal the underlying sharp details
in critical areas.



shoulder and areas like the shoes, which were too prominent in the final
image. The principle at work here is that light tones advance and dark
tones recede. Finally, Jerry recropped the image to make the subject
slightly smaller in the frame (he also added more tulle background to the
left edge of the photo to accommodate this effect). Image 9-9 shows the
final image of Katy.
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9-8. The Dodge tool was used to create
a high-key vignette.

9-9. The final portrait of Katy.



9-10, 9-11, and
9-12. These are
outtakes from
Jerry’s session
with Katy.



R hobley came to Jerry as a bride who wanted a nice gift to give
her husband on their wedding night. Rhobley is conservative

and a schoolteacher—so she was quite certain that this would not be a gift
he would expect from her. This seems to be a trend among brides, who
now frequently give a glamour book to their new husband as a wedding
gift. For the groom, it shows him that he has his own centerfold; for the
bride, it will always be a special memento of the beauty of her youth.

Makeup

Rhobley’s makeup was applied using the basic principles covered in chap-
ter 1. At the completion of her makeover, image 10-2 was created. This
was the starting point for postproduction enhancement.

RHOBLEY 81

10. Rhobley

10-1. This is Rhobley upon arriving at
Jerry’s studio.

10-2. The original image of Rhobley.



Postproduction

Rhobley was wrapped in white tulle for her image, making the shot rem-
iniscent of a wedding portrait. By bringing her body forward in the frame
and elevating her left leg, a beautiful S-curve was created in the compo-
sition. Note, however, that her hair and the veil created a shadow on the
right side of her face, putting her right eye in shadow.

The first step was to remove the unwanted background and lights with
the Clone Stamp tool. Next, Jerry softened the skin under Rhobley’s eyes
using the Clone Stamp tool with a small, soft-edged brush set to a low
opacity. He also removed a dark strand of hair close to her lip and
smoothed the shadows on her arms and legs. Image 10-3 shows the tar-
gets for these enhancements.
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10-3. The areas targeted for enhance-
ment with the Clone Stamp tool.

10-4. The Gaussian Blur filter was
applied to soften the skin, then selec-
tively erased to restore sharpness in
critical areas.



Next, working on a duplicate background layer, Jerry applied the
Gaussian Blur filter (Filter > Blur > Gaussian Blur) at a radius setting of
22 pixels. Using the Eraser tool set at 30 percent opacity and 65 percent
flow, he then revealed details across the entire body and some of the back-
ground. A second pass at 30 percent opacity was then done to reveal ad-
ditional detail, while still retaining a very soft look to the skin. Finally, a
third pass was made with the Eraser tool at the same settings to restore
sharpness on the eyes, hair, legs, shoes, the mirror, jewelry, lips, and even
the tulle (image 10-4).

At this stage, the image layers were flattened (Layer > Flatten Image).
The image was then saved and renamed (Image > Save As) and closed.
After opening the renamed image, Jerry again duplicated the duplicate
background layer.

The Clone Stamp tool was then used at 100 percent opacity to clone
the catchlight in Rhobley’s left eye (image 10-5). Because the shadow
blocked much of the light reaching her right eye, Jerry felt it needed a
catchlight of its own—so he cloned it from the left eye to the right eye.
In the detail shots of Rhobley’s face (images 10-6 and 10-7), you can see
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10-5. The process for replacing the
missing catchlight.

10-6 (left). A detail shot of the missing
catchlight.

10-7 (right). A detail shot of the
replaced catchlight.



the cloned catchlight added to the right eye. This
evens out the lighting and makes the pose and ex-
pression more natural; the eye/brain expects to see
two catchlights in the eyes.

Next, in Curves (Image > Adjustments > Curves),
Jerry brought down the blacks and brought up the
whites to, overall, create more depth and add a little
more contrast to the image (image 10-8).

Never satisfied, Jerry decided to move the subject
closer to the center of the frame so he could build up
the crimson-colored background behind her using
the Clone Stamp tool. The area was then blurred for a soft look. He also
recropped the image so that Rhobley was slightly smaller in the frame.

Finally, Jerry used the Burn tool with a small, soft-edged brush at a low
opacity to create a shadow on the left arm and leg, enhancing the depth
and roundness. He also elongated the butterfly shadow under her nose
to create a glamour-light feeling, then did some minor retouching on her
toenails to bring out the French tips. Image 10-9 shows the final portrait.

10-8. The Curves function was used to
boost the contrast.

10-9. The final portrait of Rhobley.



“When I hear the word ‘posing,’” says Jerry D, “I have this idea

of having total control over someone’s face and body. Can’t

you imagine this robot-like stick figure where you can place

every joint and body part into what you think is the perfect

pose? This might make you smile and laugh, but it’s an issue

photographers all struggle with. Every time we have a person

pose it can look cold and stiff. Rarely does it look natural.

“The well-known truth is that most people are very uncom-

fortable with having their picture taken. As people, we tend to

develop a certain level of security with the reflection we see in

the mirror. It has been a work in progress that was established

back when we first found acceptance from our peers. It’s sad

but true that people carry those same insecurities and scars

from growing up into their adult lives. We then spend our lives

overcoming fear, and we become more sophisticated in the way

we hide our feelings and project only what we want people to

see. From my standpoint, there are three perspectives from

which one perceives themselves in life: the person I show you,

the person I’d like to be, and the person I am. If you can make

them all the same, then you’ve accomplished a lot.

“Why is this important to me? When I do a portrait, I need to

know who my client is and how they see themselves. So my

first job is to listen to my client as she describes how she sees

herself—what she likes and what she would like to improve in

her appearance. As she speaks, it helps me to understand not

only her but her style. Based on this, I can start to imagine what

type of art or photo she would like to put up in her home. I

begin seeing her as a painting and I start to form an idea of

what I can do to bring out all of her beauty as an artist would.

“Once this has been established in my mind’s eye, I begin to

compose the background and set the lighting for mood. Then

it’s time to bring the client into the setting and initiate the first

pose. Understanding optics, the way the lens sees, is very im-

portant to posing. The photographer must understand that

things that are closer to the lens will appear larger, while ob-

jects that are farther away will look smaller. Since most women

carry any extra weight in their hips, thighs, and upper arms,

these are the parts you want to pose farthest away from the

lens. When you bring her face closer to the lens, on the other

hand, it presents the perfect opportunity to bring out her eyes.

I love the eyes because they truly are the windows to the soul.

“It’s also important to remembering that an image on paper

is flat, so we must pose our subjects in a way that emphasizes

the bends and curves that will add dimension and depth to the

image.

“These things are the basis for understanding how to bring

out the best in every client, every time. Learning these impor-

tant concepts is like learning the alphabet—it’s only once we’ve

learned to spell that we can begin to write our own words. It’s

easy to imitate a pose you’ve seen that works well, but really

understanding what makes that pose work provides a valuable

tool for composing your own unique images.”

POSING

10-10 and 10-11. Here are two outtakes from Rhobley’s session.
Note that the background is the same in all three images. Jerry
merely chose to paint in or paint out certain colors that best de-
fined the rest of the portrait.



R obyn is a wife and mother who makes her living as a hairdresser.
In her profession, Robyn is constantly making other women

beautiful, so she came to Jerry to spend some well-earned personal
time—during which she would be the object of a beautification session.

Makeup and Lighting

Robyn’s makeup was applied using the basic principles covered in chapter
1. At the completion of her makeover, image 11-2 was created. This was
the starting point for postproduction enhancement.
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11. Robyn

11-1 (left). This is how Robyn ap-
peared upon arriving at Jerry D’s stu-
dio.

11-2 (right). The original image of
Robyn.



To create the basic lighting pattern, a large softbox was placed above
Robyn to camera left. Opposite this, a smaller square softbox was used
for fill. Directly in front of Robyn, Jerry held a silver reflector to bounce
fill light in from the main light above. The main light was set at f/14,
which provided adequate depth of field and saturated the skin with light;
the fill light was set 11/2 stops less (at f/8), adding enough fill light to
prevent the shadows from going completely black. (Note: Because darker
complexions absorb more light than lighter ones, it is essential to use
more light and to raise the exposure level somewhat to achieve a pleasing
rendition.)

Postproduction

For this image, Jerry’s first step was to use the Patch tool to do prelimi-
nary blending of the highlights in the forehead area, the shadows under
eyes, and the creases in her underarm area (image 11-3). Jerry also used
the same tool to tone down the large highlight on Robyn’s shoulder.
Switching to the Clone Stamp tool at a 30 percent opacity setting, Jerry
then continued to blend the highlights and smooth out rough patches of
skin (image 11-4). Image 11-5 (next page) shows what the portrait looked
like after the Patch tool and Clone Stamp tool had been applied.
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11-3 (left). The areas targeted for
retouching with the Patch tool.

11-4 (right). The areas targeted for
retouching with the Clone Stamp tool.



Jerry next duplicated the background layer and applied the Gaussian
Blur filter (Filter > Blur > Gaussian Blur) at a radius of about 20 pixels.
Then, in the usual manner, he used the Eraser tool at 30 percent opacity
and 65 percent flow to restore sharpness on the important details.

At this point, Jerry flattened the layers (Layer > Flatten Image). He
saved and renamed the file (File > Save As). Working on the renamed
new original, he applied Nik’s Midnight Sepia filter to give the image a
dark and dreamy look. (Note: Nik’s filters are available at www.nik
software.com.)

Jerry next used the History Brush to selectively restore details from
the image as it appeared before the Midnight Sepia filter was applied,
bringing back the sharpness and detail he wanted to accent throughout
the frame. (Note: The History Brush allows you to paint data from a dif-
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11-5 (top left). The image after retouching with the Patch and Clone Stamp tools.

11-6 (top right). After applying the Gaussian blur filter, image details were re-
stored using the Eraser tool.

11-7. Nik’s Midnight Sepia filter was
applied to give the image a dark and
dreamy look.



ferent history state onto your current image. Go to Window > History
to view the history states for your image. In this case, Jerry painted un-
filtered image data back onto the filtered image, selectively removing the
effect of the Midnight Sepia filter.) He also used the Dodge tool to
lighten the eyes and cheekbones, making them more prominent in the
final portrait. The effect of this process is seen in image 11-8, which is
the final version of this image.
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11-8. Using the History Brush and Dodge tool, Jerry selectively
restored sharpness and added highlights. This is the final ver-
sion of the image—or at least one of the final images!

11-9. Here is another interpretation of the same image, cre-
ated using a different color palette. Jerry will sometimes be
unable to choose his favorite “final” and leave the choice up to
the client.



“I like to go into the darkened studio, then turn on one strobe

with a small softbox and place it in every position to the sub-

ject—just to watch how it works,” says Jerry. “I place the light

so the edge skims across the face and use that as my main

light. I then use a second light or reflector for fill, setting it

from one to three stops lower, depending on the feeling I’m

going for. You could also use a third light behind the subject

to add separation from the background or highlights on the

hair. Sometimes I don’t use any fill light at all; there are no

rules.

“One thing I’ve found is that there is a lot to learn—and each

day is exciting because there is always something new to see.

There are knowledgeable people who are superior technicians

when it comes to lighting, but they have trouble feeling the

light. You must trust your feelings. That is your art, and it be-

comes an interpretation of your story.

“There is a valuable lesson in understanding light and how

it is connected to the way we feel. If we think of light as a spec-

trum with thousands of tonal changes from light to dark, we

can equate it to the broad spectrum of human emotions. Light

tends to be parallel with these moods, from dark tones reflect-

ing our saddest or gloomiest moods to brighter tones causing

feelings of cheerfulness or joy—and all the thousands of light

and emotional levels in between. It’s not surprising that words

for light often play a role in describing the emotional impact of

what we see (‘her sunlit hair,’ ‘a dark gloom came over them,’

‘the twinkle in her eyes,’ ‘she glowed with the news,’ etc.).

“Light is a discovery—it can gently wrap around a subject or

communicate strength and intensity. It can also make you look

older or more youthful. Everyone can appreciate a sunset, or

the beauty of window light filtering through trees and skim-

ming across a child’s face. Photographing this moment is not

only a record of light, but also an interpretation of a feeling—

a feeling that adds value to capturing that moment in time.”

LIGHT AND ITS EMOTIONAL CONTENT

11-10 and 11-11. Here are two beautiful outtakes from Robyn’s
session.



G loria is a mother of several grown children. She is an elegant,
intelligent woman who is also at a point in her life where she

is making big changes. A year after she posed for her portraits, Jerry also
photographed her wedding. According to Jerry, it was wonderful to walk
into her home and see how her portraits graced many rooms. She is also
an excellent tango dancer and Jerry recently did some portraits/paintings
of Gloria dancing with her new husband.

When Jerry does his initial shots, like the one seen in image 12-1, he is
actually analyzing his subject to determine how he wants to photograph
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12. Gloria

12-1. This is Gloria as she appeared
just after arriving at Jerry’s studio.

12-2. This is the original capture of
Gloria’s portrait.



her. In this photo, you can see that Gloria’s hair is very fine and straight.
Because she is also tall and slender, the long lines of her hair tend to make
her look drawn. Also, Jerry noticed that her face photographed too sym-
metrically as a result of her hair being parted down the middle.

Makeup and Pose

Gloria’s makeup was applied using the basic principles covered in chapter
1. After her makeup was applied, Jerry worked on Gloria’s pose. Turning
her body sideways and having her grab her knees let her hair flow down
toward the floor, creating a fuller look and allowing him to shift the part
more to the side. Because he tilted his camera to the same angle, you
can’t tell how far forward she is actually leaning. At the completion of this
process, image 12-2 (previous page) was created. This was the starting
point for postproduction enhancement.

Postproduction

Using the Patch tool (image 12-3)—handy for these types of correc-
tions—Jerry eliminated the lines under her eyes, the laugh lines around
her mouth, and the shadow close to her left eye socket (image 12-4).
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12-3 (left). The areas targeted for
retouching with the Patch tool.

12-4 (right). This is the look after the
Patch tool was used.



To blend and “idealize” the face, Jerry next used the Clone Stamp tool
at a variety of brush sizes to blend the areas noted in image 12-5. He uses
the largest brush possible for the area being retouched, with settings typ-
ically at 30 percent opacity and 68 percent flow. Jerry blended the cheek-
bones, the makeup, and the bridge of the nose to create overall
smoothness (image 12-6).

After creating a duplicate background layer, Jerry applied the Gaussian
Blur filter at a radius setting of 14 pixels to soften the image overall
(image 12-7; next page). Then, using the Eraser tool at 30 percent opacity
and 65 percent flow, Jerry made two passes over the image. In the first,
he covered the outline of the body. In the second, made at the same set-
tings, he covered the hair and body. He then performed a third pass with
the Eraser tool set at 70 percent opacity. On this pass, he revealed sharp-
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12-5. The areas targeted for retouching with the Clone Stamp
tool.

12-6. The blending effect created with the Clone Stamp tool.



ness on the more critical details—the eyes, lips, nose, jewelry, and hair.
Image 12-8 shows the result so far—it’s beginning to look like a winning
portrait.

To add depth and contrast to the eyelashes, which subsequently adds
impact to the eyes, Jerry used the Burn tool at an exposure setting of 11
percent and a very small brush to darken the eyelashes and the rim of the
eye, creating a more substantive frame around the eyes. Jerry also in-
creased the saturation of the irises of her eyes by a slight burning in,
which made her eyes a deeper, richer blue. Compare Gloria’s eyes in
image 12-9 with her eyes in image 12-8 and you will see the dramatic im-
provement. At this point, Jerry flattened the layers in the image (Layer >
Flatten Image).
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12-7. The Gaussian Blur filter was applied to a duplicate
background layer, softening the image.

12-8. Sharpness was selectively restored to critical areas
using the Eraser tool.



For a final image treatment, Jerry used the Curves function (Image >
Adjustments > Curves) to darken the blacks and brighten the whites. He
also used the Dodge tool (at an exposure setting of 36 percent) to lighten
the background. Making it closer to pure white brightened the entire
image, giving it a high-key look. The final portrait is seen in image 12-10.
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12-9. The eyes were intensified using
the Burn tool.

12-10 (left). The final image of Gloria.

12-11 (right). Here is a variation of the final image presented in black & white, which
has its own distinct appeal. Jerry likes the blacks noticeable, so in this rendition he
further darkened the blacks (again, using the Curves function) to give the image a
bit more punch.



Thank you so much for giving me the opportunity to pose for your camera. At first, I was a little

nervous about the intimate nature of the shots, but your gentleness and encouragement made

me feel comfortable and beautiful. It ended up being one of the most fun and liberating expe-

riences I’ve ever had. I feel your portraits captured my essence. Now I have a wonderful memory

for my loved ones—and for me—to enjoy for years to come. Thank you.

A NOTE FROM GLORIA

12-12. An outtake from Gloria’s day with Jerry D.



Vandella is a bubbly, confident, and giving person who needed a
little bit of a self-image boost. All of us experience what Vandella

was feeling when she first met Jerry. She was tied up in the day-to-day
routine of her life and needed to be reminded of the fact that she is spe-
cial. When her portrait was delivered, she felt as if she had been given a
new lease on life.

Makeup

Vandella’s makeup was applied using the basic principles covered in chap-
ter 1. At the completion of this process, image 13-2 was created. This was
the starting point for postproduction enhancement.

Postproduction

The first step was to reshape her body and adjust the size of her breasts.
This was accomplished using Photoshop’s Liquify filter (Filter > Liquify).
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13. Vandella

13-1. This how Vandella looked when
she came to Jerry’s studio.

13-2. This is the first version of Van-
della’s portrait. Notice the wrinkled
tulle of the background fabric and the
lack of shape in the oversized shirt.



Liquify is essentially a separate application within Photoshop that is used
to stretch or distort areas within the photograph. In the Liquify window,
Jerry selected the Forward Warp tool with a brush size of 516, a density
setting of 50, a brush pressure of 80, and a turbulent jitter setting of 50
(this scrambles the reformatted pixels). With this tool, Jerry proceeded
to adjust her shape by pushing the pixels into the desired positions. Image
13-3 shows Vandella after the Liquify process. In the upper right quadrant
of the image, you can see that Jerry used the Clone Stamp tool to copy
new fabric into the areas that were vacated by the Liquify filter. Note,
too, the reshaped torso of Vandella.

Jerry used the Clone tool to reshape Vandella’s hips, waist and arms
(image 13-4). The tool was set to 100 opacity and flow with a brush hard-
ness of 80.
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13-3. Vandella’s torso was reshaped
using the Liquify filter. After reshap-
ing, Jerry used the Clone Stamp tool to
repair areas of the background that
became obviously distorted.

13-5. After applying the Gaussian Blur filter on a duplicate
background layer, sharpness was restored using the Eraser
tool.

13-4. The torso was then reshaped using the Clone Stamp
tool.



Next, a duplicate background layer was created. To this, Jerry applied
the Gaussian Blur filter (Filter > Blur > Gaussian Blur) at a radius setting
of 20 pixels. Working on the Gaussian Blur layer, Jerry then made two
passes with the Eraser tool set at 30 percent opacity, restoring soft detail.
Finally, he made another pass with the Eraser tool set at 80 percent opac-
ity to bring out sharp image details (image 13-5).

Jerry next applied the Burn tool as shown in image 13-6. This was ad-
justed to a 14 percent exposure setting. This technique creates shadows,
which gives the illusion of depth. With each pass, the tonal values become
deeper until the final effect is achieved.

Then, Jerry adjusted the contrast using the Brightness/Contrast func-
tion (Image > Adjustments > Brightness/Contrast). His objective was to
deepen the blacks and lighten the whites, producing better overall con-
trast (image 13-7).

13-6. The Burn tool was applied to add
shape-revealing shadows.

13-7. The contrast was enhanced to
deepen the blacks and lighten the
whites.



The final step was to use the Dodge tool, at an exposure setting of 25
percent, around the edges of the body. This cleaned up all of the distract-
ing details and gave the background a cleaner look. Image 13-8 shows
Vandella’s final portrait.

13-8. The completed image of Vandella.

A LETTER FROM VANDELLA

I had a fantastic experience with Jerry

taking my pictures. I was very nervous

when we started out, but Jerry was very

professional and made me feel comfort-

able with myself. I was extremely happy

with the photos. They ended up being

much more than I had imagined they

would be. Jerry is truly a professional at

what he does. He helps you see yourself

in a way you might never have imagined.

I have told my family members and

friends about Jerry and recommended

they use him next time they are consid-

ering photos.

13-8 and 13-9. Here are some outtakes of
Vandella created by Jerry during this sitting.



R osi is a professional businesswoman, a mother of two and a
wife. She keeps herself in top condition, dresses well, and has

her makeup just perfect when she goes out. Her “before” shot (image 14-

1) was taken on a rare day when Rosi was not feeling well and went out
without makeup.

Makeup

Rosi’s makeup was applied using the basic principles covered in chapter
1. At the completion of this process, image 14-2 was created. This was the
starting point for postproduction enhancement.

Postproduction

In the first shot of Rosi (14-2), you can see she is in fine shape—but even
so, there are little things that even beautiful women will see as imperfec-
tions. Often, these are things most other people wouldn’t even notice.
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14. Rosi

14-1. This is how Rosi looked when
she arrived at the studio.

14-2. The initial image of Rosi.



(Note: For this image, Jerry removed the nipple on her left breast because
he knew this would be a large image hanging on a wall in her home. It
also preserved our “G” rating.)

The first step was to make minor corrections with the Clone Stamp
tool. Jerry retouched an area of her abdomen with the tool set at 100 per-
cent opacity, as shown in image 14-3. With the Clone Stamp tool at 30
percent opacity and 60 percent flow, he also smoothed the fold under
her left arm, the creases in her forehead and under her eyes, and the laugh
lines around her lips. He then completed an overall skin softening with
the Clone Stamp tool, blending away any unflattering shadowing.

The next step involved slimming the nose (image 14-4). Here, he again
used the Clone Stamp tool to add the color of her cheek along either
side of the nose, making it look narrower and more ideal (image 14-5).
Continuing on with the Clone Stamp tool, Jerry straightened the line of
shadow on either side of the nose, removing any imperfections and giving
it a classic shape (image 14-6).
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14-3. The areas of the image targeted
for retouching with the Clone Stamp
tool.

14-4. The nose as it appeared in the
original image.

14-5. The Nose was slimmed by using
the Clone Stamp tool to shape the
shadows around it.

14-6. Fine-tuning the shadows on
either side of the nose gave it a
straight, classic shape.



At this point, Jerry went to File > Save As, renamed the file, then
closed it. After reopening the renamed file, Jerry applied Nik’s Midnight
Blue filter (a third-party filter available at www.niksoftware.com). The ef-
fect of this is seen in image 14-7.

Using the principle that light tones advance and dark tones recede,
Jerry next proceeded to lighten select areas of the face and body to high-
light areas of interest. To do this, he used the Dodge tool at an exposure
setting of 19 percent. Even though this is a nude, Jerry always develops
the highlights in the face to perfection so that it is the main center of in-
terest. Image 14-8 shows the targets for this process. On the opposite
side of the tonal scale, Jerry worked the shadows with the Burn tool (at
an exposure setting of 30 percent) to create depth and drama. This forced
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14-7. The Nik Midnight Blue filter was applied. 14-8. The Dodge tool was used to add highlights.

14-9 (above). The Burn tool was used to create shadows and
vignette the image.

14-10 (right). The final enhancements were made to the
eyes using the Burn and Dodge tools.



certain areas, particularly at the edges of the image, to recede into
shadow. Image 14-9 (previous page) shows the results.

Jerry’s final step was to clean up the whites of the eyes and enhance the
main catchlights, which produced a focal point for the eye. He did this
using the Dodge tool set at an exposure of 18 percent. He also used the
Burn tool, set at 9 percent exposure, along the line of the mascara/eye-
liner to produce a bit more drama in the eyes (image 14-10; previous
page). Image 14-11 shows the final version of Rosi’s portrait.
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14-11. The final version of Rosi’s
portrait.



4-12, 14-13, and 14-14. A few additional images from Rosi’s session.



In first meeting Melissa, Jerry’s initial impression of her sitting on the
red couch in his studio was that she was shy and not-very-confident

young lady. She was very soft-spoken and her demeanor revealed that she
was unsure of herself. Images 15-1 and 15-2 are two “before” images,
taken when Melissa came to Jerry D’s studio.

Determine What

the Client Wants

One of Jerry’s techniques as a
photographer and a salesman is
to ask each client some very
pointed questions about where
she would like the session to
go. These help the client focus
on the task at hand. The first
question is, “What is the pur-
pose of the photo shoot?”
Melissa replied that she wanted
to create photos to enter a
beauty pageant. Jerry then
went on to ask, “How do you
see yourself?” “How do others see you?” “How would you like to be
seen?” This helped illuminate her reasons for being there—and her an-
swers helped to engage her self-confidence. As he talked to her about her
image and self-image, Jerry could see the change in Melissa; she quickly
began to sit up straight and become more animated.

Image 15-2 is the original image that Jerry shot of Melissa. The rest of
the images shown here reveal the transformation that occurred during
the session and as a result of Jerry’s skills as an artist.
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15. Melissa

15-1 and 15-2. These are two
“befores,” taken when Melissa first
came to Jerry D’s studio.



Direct the Transformation

Much like acting, in life we must each believe in the part we are playing
in order to achieve success. If you want to be a beauty queen, then you
must project the required beauty and confidence—and radiate personality
with strong eye contact and good posture. Throughout the set of por-
traits Jerry made with Melissa (images 15-3 to 15-8), you can see the
rather remarkable changes in her.

15-3 (top). The is the original image
that Jerry shot of Melissa.

15-4 (above). The final retouched
image that Jerry created of Melissa.

15-5. As her session progressed,
Melissa grew more confident.



Jerry says that achieving this kind of transformation is what makes his
work so special. The transformation comes from his subjects, throughout
the session, coming to believe in and accept themselves. It’s not the pose,
or lighting, or retouching that makes the image special—it’s the subject’s
inner feeling of self-confidence that speaks through the image. Nowhere
is it more evident than in this series of portraits of Melissa.
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15-6, 15-7, and 15-8. As Melissa
became more confident throughout
her session, you can see a true beauty
queen begin to emerge.



Note the transformation in Kelli’s appearance from the moment
she entered the studio (image 16-1) to her appearance in the

various self-inspired images that formed her portfolio (image 16-2, 16-3,
and 16-4).

When Kelli came to the studio, as she recounted in a letter after the ses-
sion, “I had recently removed myself from a toxic relationship with a man
who once told me that he would ‘overlook’ the fact that he was not at-
tracted to me in order to keep our family together. We have a daughter
together, and he has said that she is beautiful because she possesses more
of his physical features.”

During this relationship, Kelli says that she learned to dislike herself in
many ways. “The relationship became a four-year punishment that finally
ended with him leaving me during my ninth month of pregnancy,” she
wrote. “After he left, I made up my mind and said to myself, ‘That’s it.
No one is ever going to make me feel this bad ever again!’ Now, I realize
it was less about how he made me feel bad about myself, and more about
the way he brought out what I already felt. Confidence is not necessarily
something that is seen outwardly, but it’s something that is felt deep
within us. If a woman allows herself to be treated badly, she only has her-
self to ask why.”

Kelli continued, “The hardest decision I ever had to make was to break
away from a long-term relationship and let myself become a single
mother—but in doing so, I knew I would be a better one. Being alone
has never been easier, because now I have the chance to celebrate a trans-
formation from who I was before this relationship ended and who I be-
came after.”

“Any kind of emotionally abusive partnership will drain the life out of
anyone, and the lack of confidence and self-worth can make it difficult to
break away from,” she added. “I wanted to be photographed [by Jerry]
in a way that would celebrate my independence. I wanted something that
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16. Kelli

16-1. This is how Kelli looked when
she arrived for her session.



my daughter can have so that she can see just how beautiful her mother
really was, and to reflect an image of what she might someday want to
be.”

For Kelli, her session with Jerry helped her to feel whole again. “The
photos that you’ve done are not just a memory for me,” she wrote, “but
also a constant reminder of my life’s changes, and a testimonial to my
newfound liberation.”

16-2, 16-3, and 16-4. The techniques
used to produce these “finals” are very
similar to those outlined in earlier
chapters.





Pregnancy photos have become a huge market
for portrait photographers. Ever since an iconic

nude image of the pregnant Demi Moore graced the
cover of Vanity Fair, a session of this type has been a
must-have for many mothers-to-be.

Pregnant women have a beautiful inner glow and a
healthiness to their appearance from the process of giv-
ing life. Yet, being pregnant can be hard on a woman’s
self-esteem because everything in our culture preaches
the importance of an 18-inch waist as the standard of
beauty and fitness. As women watch stretch marks ap-
pear, their bustline expand, and their waists disappear,
they often feel anything but beautiful. With the tech-
nology of today (makeup, Photoshop, etc.), however,
it’s easier than ever for photographers to create images
that allay these feelings of insecurity and depict the
beauty that many women overlook in their pregnant
forms.

This type of portraiture is a big seller for many stu-
dios. Adults won’t necessarily spend money on portraits
of themselves, but where their children are concerned,
it’s a different matter. Parents-to-be see this pregnancy
portrait as part of the process of documenting their new family.

Jerry does a lot of pregnancy portraits. It is an artform that is highly
appreciated by his clients—and growing to be more widely in demand
every day.

Cindy

Images 17-1 to 17-4 show some amazing pregnancy photos Jerry did of
Cindy. In every instance, Jerry tries to let the glow of expectant mother-
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17. Maternity Portraits

17-1, 17-2, 17-3, and 17-4. These
portraits of Cindy let the glow of
expectant motherhood shine through.





hood shine through. He varies poses and wardrobe changes much as he
does with his glamour photos, showing that even a mother-to-be can be
a centerfold! The beautification process is crucial—and Jerry D is a master
of that.

Roxanne

Here are two finished pregnancy photos that Jerry did of Roxanne. These
prints are often purchased as large wall portraits printed on canvas with
ornate gold frames. Presented in this way, the images become visual cen-
terpieces in the home—often displayed in a hallway or living room. Jerry
takes a great deal of pleasure in working with pregnant women because
he feels they are very special and should be treated as such. The Photo-
shop techniques used to create these images are not at all dissimilar to
what he does for glamour makeovers.

17-5 and 17-6. Maternity images,
such as these portraits of Roxanne,
are often purchased as large canvas
wall portraits.



Thinking back to when he was starting out and taking his first im-
ages, Jerry D remembers being in love with every image. “I would

run to the one-hour photo lab and wait for the film to be processed and
printed, only to be greatly disappointed because the highlights were
blown out, or the images were underexposed, or—worse yet—out of
focus!” he recalls. “If I was lucky enough to get a good image, I usually
thought it should have been much better than it was. In my mind, it must
have been a lack of money, or I that needed better equipment, a studio,
or better lighting. That mindset stayed with me, and I gradually accu-
mulated many different lenses and pieces of equipment—but I soon re-
alized that all the equipment in the world wouldn’t make me any better.
Only with critical evaluation of each photo will you discover the things
that will make you better. We tend to have tunnel vision as we focus on
our destination; sometimes we need to broaden our perspective and
awareness to grow.”

Jerry’s father is a talented artist with a master’s degree in art, but Jerry
notes that these abilities are not genetically transferred. As Jerry devel-
oped as an artist, however, his father’s keen eye (developed through years
of training and experience), strong foundation of artistic knowledge,
imagination, and broad perspective made his opinions valuable to the
blossoming photographer. “I must admit that it was painful to hear, when
I thought I had a great photo, that there was so much improving to be
done. With my head hung low, you could see my disappointment, and he
would say, ‘Boy, if you don’t want to know, don’t ask.’ I have been asking
ever since—and not just my father, but everyone willing to offer their
perspective,” says Jerry. Through this process, he quickly learned that we
all have different opinions—and that there’s something we can learn from
everyone. “Don’t be crushed when someone doesn’t see what you do in
your images,” he cautions, “but try to find how to craft your images so
people will feel what you do when looking at your work.”
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Conclusion

Sometimes we need to

broaden our perspective

and awareness to grow.



Deneen is a woman who suffered from breast cancer and went

through a double mastectomy before the holidays. She had a

memorable photo session with Jerry before her surgery, and

she wrote to him about the experience. “There are deeds that

transcend the day-to-day and become permanently meaning-

ful,” she wrote. “You have done that for us. I cannot thank you

enough for you professionalism, talent, and sheer kindness.

We will never forget the way that you fit us in on Thanksgiving

Day, and spoke to me about my thankfulness within my situa-

tion and my blessings. Thank you for all you’ve done for me,

and for us. I appreciate it so much. My surgery went very well,

and I am recovering with the added peace you’ve given me.”

DENEEN

It has been a little over a year now since my photo session with

Jerry D. It has been a little over a year since my first mammo-

gram, my diagnosis of breast cancer, and my surgery. As you

can imagine, it has been quite a year. Contemplating this an-

niversary brings tears to my eyes—tears of every kind. Tears of

shock and loss, of thankfulness and joy, tears for the difficulty

of change and the utter beauty of life, at the randomness of

fate and the deep goodness of people, the tragedy of fear and

the fullness of living, the weight of choice and the power of all

the forms of love I have witnessed and benefited from this past

year—because of this past year. Would I give all that up to go

back to before I knew I had breast cancer? I can’t go back is

the answer. Beauty is always changing, as is life. There are al-

ways reasons to be happy and reasons to be unhappy. We are

always adapting.

Taking photos with Jerry D was initially a practical endeavor,

to have a record of what I looked like before surgery. It became

much more than that. Taking the photos I did with Jerry, and

the way he did them, ended up being very empowering for me.

To stop in a moment and just appreciate and celebrate what-

ever and whoever I was at that moment, with pride and free-

dom, fun and sensuality—it was a wonderful feeling. I can

choose to live more in that kind of moment. That’s a choice I

can own. It’s a moment and an outlook that has nourished me

through this past year.

I look at those first pictures from a year ago and I am so con-

tent—with then and with now. Taking those photos a year ago

was so wonderful that my husband and I went back and took

pictures together. Jerry fit us in on Thanksgiving morning, just

days before my surgery. Looking at the pictures of my husband

and me makes me realize how lucky I have been and am. He,

too, has been through so very much. It’s so touching to have

captured the tenderness and devotion I know of him in a pho-

tograph. Life has brought us challenges, like it does to every-

one, but today I am cancer-free. We, today, are together and

more loving than ever.

It’s a measurable, production-oriented life we live in. I can

look at the clocks and the bottom lines and the things we think

we can’t live without and know that none of these diminish or

overpower in any way the power of goodness and love. I am

more whole and happier today than I have ever been. Go figure.

The love of others, the love of my family, the love for myself,

the love of my husband—these are the things that are impor-

tant. There are indeed times I miss the past, as we all do, but

no, I wouldn’t go back: imagine that? If I want to, I have Jerry

D’s photographs. Always, I’ll have the wonderful experience.

FROM DENEEN—ONE YEAR LATER

18-1. Here we see Deneen in her “before” image.

18-2 (facing page). Deneen in her “after” picture, which was taken
one year later.





Jerry, who says he never had the means to go to school and learn pho-
tography, also allowed images to be his teachers. “I looked at photos and
wondered how they were created. I saw where the light was coming from
and I looked at the body to see how it was posed. I have been inspired
by photographers from all over—young and old,” says Jerry, adding that,
“I think that’s why I love the WPPI [Wedding and Portrait Photogra-
phers International] convention. It brings so many talented people to-
gether—people with great images and people who share your passion.
As a kid I looked forward to Christmas. Now I can’t wait to go to WPPI
and see all the great images and talented photographers. The event reju-
venates me. It is a much-needed fix of inspiration that carries me through
until the following year.”

“I’m reminded of a story from my first year at WPPI, when I got to
see some of the greats, such as ‘Big Daddy’ Don Blair, Stephen Rudd,
Monte Zucker, and many more,” recalls Jerry. “I remember getting in-
vited to dinner and, of course, I had my favorite image on a 2x3 card.
With thoughts of having the next great image in my hands, I cornered
Monte Zucker for his opinion. What he had to say was, ‘Well, maybe if
it was in focus . . .’ Of course, he could have pointed out everything that
was wrong with it, but I knew at that point that no one loves your images
more than you. And he was so right!”

18-3. Another image from Deneen’s
studio session.



Background Layer. The bottommost image in the Layers palette.
Blush. A cosmetic used to add color on the cheeks.
Brightness/Contrast. In Photoshop, a command (Image > Adjust-

ments > Brightness/Contrast) that is used to lighten or darken images
and reduce or increase the contrast in them. This is accomplished by ad-
justing two sliders.

Burn Tool. In Photoshop, a tool used to selectively darken areas of an
image.

Catchlight. A small specular highlight that appears in the iris or pupil
of the subject’s eyes.

Clone Stamp Tool. In Photoshop, a tool used to copy data from one
area of an image onto another area of an image. This is commonly used
in image retouching.

Color Balance. A Photoshop command (Image > Adjustments >
Color Balance) used to adust the color in an image. This is accomplished
by adjusting sliders.

Contour. A cosmetic product used to create the illusion of highlights
and shadows.

Curves. A Photoshop command (Image > Adjustments > Curves)
used to adjust the color and contrast of images, as well as to lighten or
darken them.

Dodge Tool. In Photoshop, a tool used to selectively lighten areas of
an image.

Eraser Tool. In Photoshop, a tool used to eliminate the image data on
a given layer.

Eyeliner. A cosmetic applied at the lashline to make the eyes look more
defined.

Eyeshadow. A cosmetic used to add color and contouring to the eye
area.

Fill Light. A secondary light source used to fill in the shadows created
by the main light.
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Forward Warp. In the dialog box for Photoshop’s Liquify filter, a tool
that allows you to push pixels into new positions.

Free Transform. In Photoshop, a function that allows you to manu-
ally adjust the scale and aspect ratio of a layer or selection.

Gaussian Blur Filter. In Photoshop, a filter (Filter > Blur > Gaussian
Blur) used to unfocus a selection or layer by an adjustable amount.

High-Key Lighting. A type of lighting characterized by a low lighting
ratio and a predominance of light tones.

Highlight. A light-to-white area in an image that helps to show the
shape of the subject. Highlights tend to advance visually toward the
viewer. See also Specular Highlight.

Highlighter. A cosmetic used to create light areas that will be per-
ceived as highlights.

History Brush Tool. In Photoshop, a tool used to paint data onto an
image from a different history state.

Image Rotation. In Photoshop, a fuction that allows you to turn cer-
tain image elements to position them at different angles.

Lasso Tool. In Photoshop, a tool used to trace around areas in order
to select them.

Laugh Lines. The vertical grooves in the face adjacent to the mouth.
Also called furrows. These are made deeper when the subject smiles.

Lighting Ratio. The difference in intensity between the highlight side
of the face and the shadow side of the face.

Lip Gloss. A reflective cosmetic used to add shine on the lips.
Lip Liner. A cosmetic used to define and shape the outline of the lips.
Lipstick. A cosmetic used to add color to the lips.
Liquify Filter. In Photoshop, a filter (Filter > Liquify) that allows you

to push, pull, rotate, reflect, pucker, and bloat any area of an image.
Low-Key Lighting. A type of lighting characterized by a high lighting

ratio and a predominance of dark tones.
Main Light. The light source used to establish the lighting pattern

and define the facial features of the subject.
Marquee Tool. In Photoshop, a tool that enables you to make

round/oval or square/rectangular selections.
Mascara. A cosmetic applied to the eyelashes to make them appear

longer, thicker, and darker.
Move Tool. In Photoshop, a tool that allows you to reposition some

image elements by clicking and dragging.
Noise Filter. In Photoshop, a filter (Filter > Noise > Add Noise) used

to add a speckled appearance to an image.
Patch Tool. In Photoshop, a tool that allows you to select a “problem
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area,” then drag that selection to another area of the image. The image
data in that area will then automatically be blended over the “problem
area.”

RAW file. A file format on digital cameras in which all of the data cap-
tured by the image sensor is stored without being processed by the cam-
era’s software.

Reflector. Any device used to redirect light by bouncing it.
Sepia. A brownish tint added to an image.
Shadow. A dark-to-black area in an image that helps to show the shape

of the subject. Shadows tend to recede visually from the viewer.
Softbox. A diffused light source housed in a box-shaped reflector. The

front of the box is translucent material; the side pieces of the box are
opaque, but the interior walls are coated with a reflective material (such
as foil) to optimize light output.

Specular Highlights. Sharp, bright highlights.
Vignette. A semicircular, soft-edged border around the edges of the

image, encircling the main subject. Vignettes can be either light or dark
in tone and are used to draw viewers’ eyes to the subject.
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A

Albums, 44

B

Background layer, duplicate, 26,
28, 32, 38–39, 42, 47, 48,
55, 63, 78, 83, 88, 93–94,
98–99

Background light, 41, 90
Background, retouching, 33
Black & white images, 95
Blush, 12, 16
Bra strap, correcting twisted,

53–55
Bridal portraits, 81–85
Brightness/Contrast, 49, 99
Brushes, makeup, 12
Burn tool, 42–43, 47, 65–67, 74,

78, 84, 94, 99, 103–4

C

Catchlights, adding, 83–84
Cheekbones, 13–14, 16–17
Clone Stamp tool, 25, 26, 28,

31–32, 36–37, 41, 46, 47,
53, 55, 57, 62–63, 72–73,
77–78, 82–84, 87, 88, 93,
98–99, 102

Color Balance, 29, 67
Composition, 77, 82

Contouring powder, 12–17
on highlights, 12, 16–17
on shadows, 12–15

Contrast, controlling, 10, 15, 19,
24, 49, 57, 65, 84, 94, 99

Cropping, 66–67, 79, 84
Curves, 29, 47, 49, 57, 65, 84, 95

D

Depth of field, 87
Directing the subject, 107
Distortion, lens, 85
Dodge tool, 26, 33–34, 65,

78–79, 89, 95, 100, 103–4

E

Education, 75
Eraser tool, 28–29, 32–33, 39, 42,

47, 48, 56, 63–65, 78, 83,
88, 93, 94, 98–99

Exposure, 87
Eyebrows, 19–21
Eyeliner, 19
Eyeshadow, 12, 17–21
Eyes, 17–21, 26, 33, 37, 42, 47,

49, 56, 73, 77, 78, 82–84,
87, 89, 92, 94–95, 102, 104

catchlights, 83–84, 104
circles under, 77, 78, 82, 87,

92, 102
color, enhancing, 94–95

Eyes (cont’d)
dark shadow in the crease, 17
eyebrows, 19–21
eyeliner, 19
eyeshadow color, 18
highlights, 18
mascara, 19
retouching, 26, 33, 83–84, 94,

104
sharpness of, 33, 37, 52, 47, 49,

56, 73, 83, 89

F

Face, evaluating, 12
File format, 26–27
Fill light, 46, 52, 90
Forehead, shine on, 87
Free Transform, 55, 66–67

G

Gaussian blur, 27–28, 29, 32–33,
42, 47–48, 55, 63, 64, 78,
82, 83, 88, 93–94, 98–99

Glamour books, 44

H

Hairstyling, 23, 76
Highlights, 12, 16–17, 18

contouring with makeup,
12, 16–17, 18

History Brush, 73, 88–89
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J

Jawline, 15
JPEG files, 27

L

Lasso tool, 55
Laugh lines, 46, 92, 102
Lens distortion, 85
Lighting, 41, 46, 52, 87, 90

background light, 41, 90
emotional content of, 90
fill light, 46, 52, 90
main light, 46, 52, 87, 90

Lip gloss, 12, 22
Lipliner, 12, 21
Lips, 21–22, 42, 47, 56, 83, 94,

102
lines around, 102
shaping, 21–22
sharpness, 42, 47, 56, 83, 94

Lipstick, 12, 22
Liquify filter, 38, 97–98

Forward Warp tool, 38, 98
turbulent jitter setting, 98
Twirl Clockwise tool, 38

M

Main light, 46, 52, 87, 90
Marquee tool, 66–67
Mascara, 12, 19
Maternity portraits, 112–14
Midnight Blue filter, 103
Midnight Sepia filter, 73–74,

88–89
Move tool, 55

N

Nik Software, 73, 88–89, 103
Noise filter, 65–67
Nose, 14, 17, 25, 47, 102

contouring with makeup, 14, 17
retouching in Photoshop, 25,

47, 102

P

Patch tool, 31–32, 53, 72–73,
87–88

Posing, 77, 85, 92
Pregnancy portraits, 112–14

R

RAW files, 26
Reflector, 52, 87

S

Schembri, Martin, 44
Self image, 7, 109–10
Sharpness, maintaining critical,

28–29
Skin, smoothing, 24–27, 31–33,

42, 47, 53, 55–57, 62–65,
72–73, 77, 82–83, 87–88,
92–94, 102

Skin tone, exposing correctly, 87
Slimming, 31–33, 36–37, 47–49,

61–67, 102
Softbox, 46, 87, 90
Sponge, 12

T

Testimonials, 35, 39, 58–59, 69,
70, 96, 100, 109–10

V

Vignette, 42–43, 66–67, 78, 103

W

Wall portraits, 61, 114

Y

You Select It software, 44
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THE PORTRAIT PHOTOGRAPHER’S
GUIDETO POSING

Bill Hurter
Posing can make or break an image. Now you can
get the posing tips and techniques that have
propelled the finest portrait photographers in the
industry to the top. $34.95 list, 8.5x11, 128p, 200
color photos, index, order no. 1779.

GROUP PORTRAIT
PHOTOGRAPHY HANDBOOK
2nd Ed.

Bill Hurter
Featuring over 100 images by top photographers,
this book offers practical techniques for com-
posing, lighting, and posing group portraits—
whether in the studio or on location. $34.95 list,
8.5x11, 128p, 120 color photos, order no. 1740.

PORTRAIT PHOTOGRAPHER’S
HANDBOOK, 3rd Ed.

Bill Hurter
A step-by-step guide that easily leads the reader
through all phases of portrait photography. This
book will be an asset to experienced photographers
and beginners alike. $34.95 list, 8.5x11, 128p,
175 color photos, order no. 1844.

WEDDING PHOTOGRAPHER’S
HANDBOOK

Bill Hurter
Learn to produce images with technical proficiency
and superb, unbridled artistry. Includes images and
insights from top industry pros. $34.95 list,
8.5x11, 128p, 180 color photos, 10 screen shots,
index, order no. 1827.

RANGEFINDER’S
PROFESSIONAL
PHOTOGRAPHY

edited by Bill Hurter
Editor Bill Hurter shares over one hundred
“recipes” from Rangefinder’s popular cookbook
series, showing you how to shoot, pose, light, and
edit fabulous images. $34.95 list, 8.5x11, 128p,
150 color photos, index, order no. 1828.

THE BEST OF PROFESSIONAL
DIGITAL PHOTOGRAPHY

Bill Hurter
Digital imaging has a stronghold on photography.
This book spotlights the methods that today’s
photographers use to create their best images.
$34.95 list, 8.5x11, 128p, 180 color photos, 20
screen shots, index, order no. 1824.

THE BEST OF
ADOBE® PHOTOSHOP®

Bill Hurter
Rangefinder editor Bill Hurter calls on the in-
dustry’s top photographers to share their strategies
for using Photoshop to intensify and sculpt their
images. $34.95 list, 8.5x11, 128p, 170 color
photos, 10 screen shots, index, order no. 1818.

EXISTING LIGHT
TECHNIQUES FOR WEDDING AND PORTRAIT
PHOTOGRAPHY

Bill Hurter
Learn to work with window light, make the most
of outdoor light, and use fluorescent and incan-
descent light to best effect. $34.95 list, 8.5x11,
128p, 150 color photos, index, order no. 1858.

THE BEST OF
PORTRAIT PHOTOGRAPHY
2nd Ed.

Bill Hurter
View outstanding images from top pros and learn
how they create their masterful classic and con-
temporary portraits. $34.95 list, 8.5x11, 128p,
180 color photos, index, order no. 1854.

100TECHNIQUES FOR
PROFESSIONAL WEDDING
PHOTOGRAPHERS

Bill Hurter
Top photographers provide tips for becoming a
better shooter—from optimizing your gear, to
capturing perfect moments, to streamlining your
workflow. $34.95 list, 8.5x11, 128p, 180 color
images and diagrams, index, order no. 1875.

OTHER BOOKS FROM

Amherst Media®



SIMPLE LIGHTING
TECHNIQUES
FOR PORTRAIT PHOTOGRAPHERS

Bill Hurter
Make complicated lighting setups a thing of the
past. In this book, you’ll learn how to streamline
your lighting for more efficient shoots and more
natural-looking portraits. $34.95 list, 8.5x11,
128p, 175 color images, index, order no. 1864.

THE BEST OF
PHOTOGRAPHIC LIGHTING 2nd

Ed.

Bill Hurter
Top pros reveal the secrets behind their studio,
location, and outdoor lighting strategies. Packed
with tips for portraits, still lifes, and more. $34.95
list, 8.5x11, 128p, 200 color photos, index, order
no. 1849.

CHILDREN’S PORTRAIT
PHOTOGRAPHY HANDBOOK

Bill Hurter
Packed with inside tips from industry leaders, this
book shows you the ins and outs of working with
some of photography’s most challenging subjects.
$34.95 list, 8.5x11, 128p, 175 color images,
index, order no. 1840.

MASTER POSING GUIDE FOR
WEDDING PHOTOGRAPHERS

Bill Hurter
Learn a balanced approach to wedding posing and
create images that make your clients look their very
best while still reflecting the spontaneity and joy of
the event. $34.95 list, 8.5x11, 128p, 180 color
images and diagrams, index, order no. 1881.

MASTER LIGHTING GUIDE
FOR WEDDING PHOTOGRAPHERS

Bill Hurter
Capture perfect lighting quickly and easily at the
ceremony and reception—indoors and out.
Includes tips from the pros for lighting individuals,
couples, and groups. $34.95 list, 8.5x11, 128p,
200 color photos, index, order no. 1852.

POSINGTECHNIQUES
FOR PHOTOGRAPHING
MODEL PORTFOLIOS

Billy Pegram
Learn to evaluate your model and create flattering
poses for fashion photos, catalog and editorial
images, and more. $34.95 list, 8.5x11, 128p, 200
color images, index, order no. 1848.

JEFF SMITH’S LIGHTING FOR
OUTDOOR AND LOCATION
PORTRAIT PHOTOGRAPHY
Learn how to use light throughout the day—
indoors and out—and make location portraits a
highly profitable venture for your studio. $34.95
list, 8.5x11, 128p, 170 color images, index, order
no. 1841.

MONTE ZUCKER’S
PORTRAIT PHOTOGRAPHY
HANDBOOK
Acclaimed portrait photographer Monte Zucker
takes you behind the scenes and shows you how to
create a “Monte Portrait.” Covers techniques for
both studio and location shoots. $34.95 list,
8.5x11, 128p, 200 color photos, index, order no.
1846.

WEDDING PHOTOGRAPHY
CREATIVE TECHNIQUES FOR LIGHTING,
POSING, AND MARKETING, 3rd Ed.

Rick Ferro
Creative techniques for lighting and posing wed-
ding portraits that will set your work apart from
the competition. Covers every phase of wedding
photography. $34.95 list, 8.5x11, 128p, 125 color
photos, index, order no. 1649.

CORRECTIVE LIGHTING,
POSING & RETOUCHING FOR

DIGITAL PORTRAIT PHOTOGRAPHERS, 2nd Ed.

Jeff Smith
Learn to make every client look his or her best by
using lighting and posing to conceal real or
imagined flaws—from baldness, to acne, to figure
flaws. $34.95 list, 8.5x11, 120p, 150 color photos,
order no. 1711.

MASTER POSING GUIDE FOR
PORTRAIT PHOTOGRAPHERS

J. D.Wacker
Learn the techniques you need to pose single
portrait subjects, couples, and groups for studio or
location portraits. Includes techniques for photo-
graphing weddings, sports teams, children, special
events, and much more. $34.95 list, 8.5x11, 128p,
80 photos, order no. 1722.

DOUG BOX’S
GUIDETO POSING
FOR PORTRAIT PHOTOGRAPHERS

Based on Doug Box’s popular workshops for
professional photographers, this visually intensive
book allows you to quickly master the skills needed
to pose men, women, children, and groups.
$34.95 list, 8.5x11, 128p, 200 color images,
index, order no. 1878.



500 POSES FOR
PHOTOGRAPHING WOMEN

Michelle Perkins
A vast assortment of inspiring images, from head-
and-shoulders to full-length portraits, and classic to
contemporary styles—perfect for when you need a
little inspiration to create a new pose. $34.95 list,
8.5x11, 128p, 500 color images, order no. 1879.

POWER MARKETING, SELLING,
AND PRICING
A BUSINESS GUIDE FOR WEDDING AND
PORTRAIT PHOTOGRAPHERS, 2ND ED.

Mitche Graf
Master the skills you need to take control of your
business, boost your bottom line, and build the life
you want. $34.95 list, 8.5x11, 144p, 90 color
images, index, order no. 1876.

PHOTOGRAPHER’S GUIDE TO

WEDDING ALBUM
DESIGN AND SALES, 2nd Ed.

Bob Coates
Learn how industry leaders design, assemble, and
market their albums with the insights and advice in
this popular book. $34.95 list, 8.5x11, 128p, 175
full-color images, index, order no. 1865.

LIGHTING FOR
PHOTOGRAPHY TECHNIQUES FOR

STUDIO AND LOCATION SHOOTS

Dr. Glenn Rand
Gain the technical knowledge of natural and
artificial light you need to take control of every
scene you encounter—and produce incredible
photographs. $34.95 list, 8.5x11, 128p, 150 color
images/diagrams, index, order no. 1866.

MINIMALIST LIGHTING
PROFESSIONAL TECHNIQUES FOR
STUDIO PHOTOGRAPHY

KirkTuck
Technological advances have made it easy and
inexpensive to set up your own studio for portrait
photography, commercial photography, and more.
$34.95 list, 8.5x11, 128p, 190 color images and
diagrams, index, order no. 1880.

MINIMALIST LIGHTING
PROFESSIONAL TECHNIQUES FOR
LOCATION PHOTOGRAPHY

KirkTuck
Use small, battery-operated flashes and lightweight
accessories to get the top-quality results you want
on location! $34.95 list, 8.5x11, 128p, 175 color
images and diagrams, index, order no. 1860.

THE SANDY PUC’ GUIDE TO

CHILDREN’S PORTRAIT
PHOTOGRAPHY
Learn how Puc’ handles every client interaction
and session for priceless portraits, the ultimate
client experience, and maximum profits. $34.95
list, 8.5x11, 128p, 180 color images, index, order
no. 1859.

AVAILABLE LIGHT
PHOTOGRAPHIC TECHNIQUES FOR USING
EXISTING LIGHT SOURCES

Don Marr
Learn to find great light, modify not-so-great light,
and harness the beauty of unusual light sources in
this step-by-step book. $34.95 list, 8.5x11, 128p,
135 color images, index, order no. 1885.

JEFF SMITH’S GUIDE TO

HEAD AND SHOULDERS
PORTRAIT PHOTOGRAPHY

Jeff Smith shows you how to make head and
shoulders portraits a more creative and lucrative
part of your business—whether in the studio or on
location. $34.95 list, 8.5x11, 128p, 200 color
images, index, order no. 1886.

THE PHOTOGRAPHER’S GUIDE TO

MAKING MONEY
150 IDEAS FOR CUTTING COSTS AND
BOOSTING PROFITS

Karen Dórame
Learn how to reduce overhead, improve market-
ing, and increase your studio’s overall profitability.
$34.95 list, 8.5x11, 128p, 200 color images,

PROFESSIONAL SECRETS OF
NUDE & BEAUTY
PHOTOGRAPHY

Bill Lemon
Learn the technical aspects of composition and
posing as well as how to ensure the comfort of
your nude models. For photographers of all levels.
$29.95 list, 8.5x11, 128p, 60 b&w photos, order
no. 1709.

ROLANDO GOMEZ’S
GLAMOUR PHOTOGRAPHY
PROFESSIONAL TECHNIQUES AND IMAGES

Learn how to create classy glamour portraits your
clients will adore. Rolando Gomez takes you
behind the scenes, offering invaluable technical
and professional insights. $34.95 list, 8.5x11,
128p, 150 color images, index, order no. 1842.



MASTER GUIDE FOR
GLAMOUR PHOTOGRAPHY

Chris Nelson
Establish a solid rapport with your model, ensure a
successful shoot, and master the essential digital
fixes your clients demand. Includes lingerie, semi-
nude, and nude images. $34.95 list, 8.5x11, 128p,
200 color photos, index, order no. 1836.

GARAGE GLAMOURTM

DIGITAL NUDE AND BEAUTY PHOTOGRAPHY
MADE SIMPLE

Rolando Gomez
Glamour photography is more popular than ever.
This book will show you how to produce sultry,
creative glamour images with a minimum of
equipment. $34.95 list, 8.5x11, 128p, 150 color
photos, index, order no. 1820.

POSING FOR PORTRAIT
PHOTOGRAPHY
A HEAD-TO-TOE GUIDE

Jeff Smith
Author Jeff Smith teaches surefire techniques for
fine-tuning every aspect of the pose for the most
flattering results. $34.95 list, 8.5x11, 128p, 150
color photos, index, order no. 1786.

PROFESSIONAL
PORTRAIT LIGHTING
TECHNIQUES AND IMAGES
FROM MASTER PHOTOGRAPHERS

Michelle Perkins
Get a behind-the-scenes look at the lighting tech-
niques employed by the world’s top portrait pho-
tographers. $34.95 list, 8.5x11, 128p, 200 color
photos, index, order no. 2000.

PROFESSIONAL
PORTRAIT POSING
TECHNIQUES AND IMAGES
FROM MASTER PHOTOGRAPHERS

Michelle Perkins
Learn how master photographers pose subjects to
create unforgettable images. $34.95 list, 8.5x11,
128p, 175 color images, index, order no. 2002.

PROFESSIONAL
MODEL PORTFOLIOS
A STEP-BY-STEP GUIDE FOR
PHOTOGRAPHERS

Billy Pegram
Learn to create portfolios that will get your clients
noticed—and hired! $34.95 list, 8.5x11, 128p,
100 color images, index, order no. 1789.

MASTER LIGHTING GUIDE
FOR PORTRAIT PHOTOGRAPHERS

Christopher Grey
Efficiently light executive and model portraits,
high and low key images, and more. Master
traditional lighting styles and use creative modi-
fications that will maximize your results. $29.95
list, 8.5x11, 128p, 300 color photos, index, order
no. 1778.

SOFTBOX LIGHTING
TECHNIQUES
FOR PROFESSIONAL PHOTOGRAPHERS

Stephen A. Dantzig
Learn to use one of photography’s most popular
lighting devices to produce soft and flawless effects
for portraits, product shots, and more. $34.95 list,
8.5x11, 128p, 260 color images, index, order no.
1839.

50 LIGHTING SETUPS FOR
PORTRAIT PHOTOGRAPHERS

Steven H. Begleiter
Filled with unique portraits and lighting diagrams,
plus the “recipe” for creating each one, this book is
an indispensible resource you’ll rely on for a wide
range of portrait situations and subjects. $34.95
list, 8.5x11, 128p, 150 color images and diagrams,
index, order no. 1872.

DIGITAL PHOTOGRAPHY
BOOT CAMP, 2nd Ed.

Kevin Kubota
This popular book based on Kevin Kubota’s sell-
out workshop series is now fully updated with
techniques for Adobe Photoshop and Lightroom.
It’s a down-and-dirty, step-by-step course for
professionals! $34.95 list, 8.5x11, 128p, 220 color
images, index, order no. 1873.

SCULPTING WITH LIGHT

Allison Earnest
Learn how to design the lighting effect that will
best flatter your subject. Studio and location
lighting setups are covered in detail with an
assortment of helpful variations provided for each
shot. $34.95 list, 8.5x11, 128p, 175 color images,
diagrams, index, order no. 1867.

STEP-BY-STEP WEDDING
PHOTOGRAPHY

DamonTucci
Deliver the top-quality images that your clients
demand with the tips in this essential book. Tucci
shows you how to become more creative, more
efficient, and more successful. $34.95 list, 8.5x11,
128p, 175 color images, index, order no. 1868.
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MASTER THE SKILLS YOU NEED TO
MAKE REAL WOMEN LOOK AND FEEL LIKE MODELS

Acclaimed photographer Jerry D reveals the secrets of
creating glamour images that bring out the very best

in every woman (and hide all those little problem areas that
no subject wants to see!). Step-by-step images and instruc-
tions walk you through the entire process, from careful
styling to powerful postproduction techniques.

FEATURES:

Comprehensive makeup techniques for sculpting the face with
highlights and shadows

Eliminating blemishes, wrinkles, and other problems for a smooth, soft
complexion—head to toe

Using the Clone Stamp and Patch tools to manipulate shadows and
highlights, reshaping any problem areas on the body

Soft-focus effects for a dreamy look that doesn’t compromise critical
sharpness

Enhancing the eyes for a more vibrant look

Subtle techniques for narrowing and straightening the nose

Selective dodging and burning techniques for truly refined effects

Slimming the waist, arms, hips—and any other area of the body

Simple artistic effects for more appealing backgrounds

Tips for working with women on glamour shoots

Ideas for designing and selling glamour portrait products, such as wall
portraits and albums
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